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1 Overview
This document presents an overview of the techniques and tools available for using HP Insight
Global Workload Manager software for Integrity (or gWLM.) It exposes you to the essentials
and allows you to quickly start using gWLM. This document is intended to be used by Virtual
Server Environment (VSE) system administrators, VSE application administrators, and other
technical professionals involved with data center operations, administration, and planning. An
understanding of HP-UX system administration concepts and procedures is assumed
This chapter provides an overview of gWLM, including benefits, key concepts and terms, and
the gWLMmanagement model.

gWLM Overview
gWLM allows you to centrally define resource-sharing policies that you can use across multiple
HP servers. Using these policies can increase system utilization and facilitate controlled sharing
of system resources. In addition, gWLM provides both real-time and historical monitoring of
the resource allocation.
gWLMconsists of a VSECentralManagement Server, or CMS. You configure gWLMandmonitor
your workloads from the system where the CMS software is installed. Also, you use agent
software on the systems where you have workloads you want gWLM to manage.

Benefits of using gWLM
The benefits of using gWLM include:
• Better use of existing server capacity

Typically, servers are set up with a single workload and ample reserve capacity to handle
the peak demand of that workload. gWLM allows you to combine multiple workloads with
differing demand patterns on a single server and make use of the idle capacity—when it is
not needed by your mission-critical workload.

• Confidence that mission-critical workloads get the required resources
Even with multiple workloads on a server, you can ensure your mission-critical workload
gets the resources it needs. gWLM automatically adjusts resource allocation, making it easy
to share resources when they are plentiful, and to dedicate resources to workloads during
spikes in resource demand.

• Reduced system administration costs
With gWLM, you can combine more workloads on fewer servers, thereby reducing
administration costs.

Comparison of PRM, WLM, and gWLM features
Process Resource Manager (PRM), Workload Manager (WLM), and gWLM all enable you to
control system resources. Use only one of these products at a time on a system.
For a detailed comparison ofWLMand gWLM features, see thewhite paperMigrating fromWLM
to gWLM available from http://www.hp.com/go/insightdynamics/docs. As for comparing PRM
and gWLM features, gWLM provides most of the PRM functionality. However, gWLM does not
provide the following PRM features:
• Memory controls
• Disk I/O controls
• Simultaneous management of processor sets and fss groups within a single HP-UX image
• Noncapped mode
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• Integration with HP-UX Security Containment
• Integration with netgroup user lists
• Integration with HP System Management Homepage (SMH)

Concepts and terms for using gWLM
Here are some concepts and terms to know when using gWLM:
Workload The collection of processes executing within a single

compartment. The compartment can be an nPartition
(npar), a virtual partition (vPar), a virtual machine
provided by HP Integrity Virtual Machines (hpvm), a
processor set (pset), or a Fair Share Scheduler (fss) group.
gWLMmanages a workload by adjusting the system
resource allocations for its compartment. (For background
information on nPars, vPars, virtual machines, psets, and
fss groups, refer to the section “The gWLMmanagement
model” (page 10).)

Compartment An npar, a vPar, a virtual machine, a pset, or an fss group
with its resource allocation being managed by gWLM.
Multiple compartments are grouped to form a shared
resource domain, or SRD. The compartments all share the
resources within the SRD. Each compartment holds a
workload and can be in only one deployed SRD. gWLM
manages each workload by adjusting the resource
allocation for its compartment.
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Shared Resource Domain (SRD) A collection of compartments that can share system
resources. The compartments can be nPars, vPars, virtual
machines, psets, or fss groups. For example, a server
containing nPars can be an SRD—as long as the
requirements in “The gWLMmanagement model”
(page 10) are met. Also, a server or an npar divided into
vPars can be an SRD for its vPar compartments. Similarly,
a server or an npar divided into virtual machines can be
an SRD for its virtual machine compartments.
gWLM allows you to nest compartments. gWLM then
manages resources for the various levels of compartments.

Policy A collection of settings that instruct gWLMhow tomanage
a workload’s resources. For example, a policy can indicate
the amount of CPU resources a workload owns (and is
allocated when needed), as well as how much of those
resources the workload can lend to other workloads.
A single policy can be associated with, or applied to,
multiple workloads.
For more information on policies, see “Policy types”
(page 15).

Mode Twomodes are available: advisory andmanaged.Advisory
mode allowsyou to seewhatCPU resource requests gWLM
would make for a workload—without actually affecting
resource allocation.
Advisorymode is not available for SRDs containing virtual
machines, psets, or fss groups due to the nature of these
compartments.
Use thismodewhen creating and fine-tuning your policies.
Once you are comfortablewith your policies, usemanaged
mode to have gWLM automatically adjust the resource
allocations for your defined workloads.
You can only set themode on the SRD level. All workloads
within an SRD operate in the same mode, either advisory
or managed.

Deploy Enable gWLM control of an SRD.
Deploying an SRD in managed mode enables gWLM
control of resource allocationwithin the SRD. For example,
in an SRDbased on a vPar that has psets for compartments,
deploying an SRD in managed mode allows gWLM to
actively migrate cores among psets. (A core is the actual
data-processing engine within a processor. A single
processor might have multiple cores.)
Whendeploying an SRD in advisorymode, gWLMsimply
reports what the allocation would be—without actually
affecting resource allocations on a system.
Advisorymode is not available for SRDs containing virtual
machines, psets, or fss groups due to the nature of these
compartments.
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Undeploy Disable gWLM’s management of resources in a specified
SRD.
If an SRD is in managed mode, undeploying stops the
migration of system resources among workloads in the
SRD. If the SRD is in advisory mode, gWLM no longer
provides information on what requests would have been
made.

The gWLM management model
gWLM enables utility computing across a data center by providing resource-sharing policies
that you centrally create andmonitor. gWLMmoves resources among the workloads in a shared
resource domain (SRD) as needed—based on the policies you specify.
gWLM allows you to manage resource allocations for several types of system divisions, as
discussed below. These divisions are referred to as compartments in gWLM.
• HP-UX Hardware Partitions (npar)

A hardware partition, also known as an nPartition or npar, is a physical partition of a server,
where each npar runs its own instance of the HP-UX operating system (which can include
use of HP Integrity virtual machines) or is divided into virtual partitions.
Using the HP Instant Capacity product, gWLM simulates the movement of CPU resources
among nPars by turning off an active core in one npar then turning on a deactivated core
in another npar in the same complex. Thus, the first npar has one less active core, while the
second npar has one additional active core. (gWLMmaintains the number of active cores,
honoring the Instant Capacity usage rights. As a result, no additional costs are incurred.)
Combining gWLM A.04.00.07 or later and an appropriate version of the iCAP software,
gWLM's ability tomanage nPars using iCAP is extended acrossmultiple complexes that are
members of the same Global iCAP group.

• HP-UX Virtual Partitions (vPar)
A virtual partition is a software partition of a server or of a single nPartition, where each
virtual partition runs its own instance of the HP-UX operating system. A virtual partition
cannot span an nPartition boundary.

• HP Integrity Virtual Machines (hpvm)
Virtual machines are a robust soft-partitioning and virtualization technology that provides
operating system isolation,with sub-core allocation granularity and shared I/O. These virtual
machines can run a variety of operating systems. gWLM can manage a virtual machine
regardless of the operating system running inside it.

• HP-UX Processor sets (psets)
A processor set is a collection of cores (formerly known as CPUs) grouped together for the
exclusive access by processes assigned to that processor set. Processor sets form partitions
within a single operating system image.

• HP-UX Fair Share Scheduler groups (fss groups)
A group of processes that has its CPU resource allocation managed by the Fair Share
Scheduler that is available with HP-UX. A benefit of fss groups is their granularity: You can
allocate fractions of CPU resources, rather than only whole cores, to the group of processes.
These groups form partitions within a single operating system image.
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For more information on these system divisions, visit:
• HP Virtual Server Environment website:

http://www.hp.com/go/vse

• The “Technical Documentation website for HP Virtual Server Environment (VSE)” website:
http://www.hp.com/go/insightdynamics/docs

• The “Global Workload Manager” topic and the glossary in the online help for gWLM,
available in gWLM’s graphical interface in HP SIM.

gWLMmanages resources based on the following model:
1. You define an SRD by:

a. Deciding which of your systems you want to manage and what type of compartments
you want to use.
gWLMmanages existing nPars, vPars, and virtualmachines. It canmanage your existing
psets as well as create new ones. It creates fss groups for you.

b. Associating each workload with a compartment.
For nPars, vPars, and virtual machines, the compartment itself defines the workload.
For psets and fss groups, you define the workload based on applications, users, or
process IDs.

c. Associating a policywith theworkload indicating howgWLMshould allocate resources
to the workload's compartment.
gWLM comes with several policies and also lets you define your own. You can use a
single policy for multiple workloads, minimizing the number of policies, if desired.

2. Once the SRD is deployed:
a. gWLMmonitors the CPU resource consumption of all theworkloads in the SRDduring

the current allocation interval.
b. At the end of the interval, gWLM adjusts the CPU resource allocations for the

compartments in accordancewith the policies. It alsomakes the allocation data available
for real-time and historical reports.

c. gWLM repeats the previous two substeps.

For information on what types of workloads to combine for optimal resource utilization, refer
to the online help topic “Getting the Most Out of gWLM.”

How gWLM allocates CPU resources
gWLM addresses priority levels from highest to lowest, allocating resources to all requests at a
given priority level before considering lower priority requests. If, at some priority level, all
requests cannot be satisfied, the remaining resources are distributed so that the total resource
allocation for each workload is as near the proportion of its weight relative to the sum of all the
weights as possible. If gWLM has satisfied all resource requests at all priorities and there are
resources still to be allocated, it will distribute the remaining resources by weight. Again, this is
so that the total resource allocation for each workload is as near the proportion of its weight
relative to the sum of all the weights as possible.
Table 1-1 lists the default weights for the various policy types. For policies with weights, you
can also set the weight explicitly.
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Table 1-1 Default weights by policy type

Default weightPolicy type

N/A
(You cannot deploy an SRD where all the workloads with fixed policies are
not satisfied.)

Fixed

1Utilization

Equal to its owned valueOwnBorrow

1Custom

NOTE: To ensure CPU resource allocations behave as expected for OwnBorrow policies, the
sum of the CPU resources owned cannot exceed the number of cores in the SRD. (However, if
the sum is less than the number of cores in the SRD, the excess is distributed to all compartments
in proportion to the amounts owned. Thus, workloads will routinely get more than they are
due.)

Available interfaces
There are two interfaces for controlling and monitoring gWLM:
• HP Systems Insight Manager

Aweb-based interface accessed through the Shared Resource Domain tab reached through
the Tools→Virtualization Manager... menu in HP Systems Insight Manager (access HP
Systems Insight Manager via the URL http://hostname:280 where hostname represents the
name of your Virtual Server Environment Management Software CMS).
To orient yourself with gWLM, refer to the gWLM Home page inside this interface by
selectingTools→Virtualization Manager... from theHP SIMmenu bar and then theShared
Resource Domain tab and then from the VSE Management menu bar:
Tools→Global Workload Manager→Getting Started - gWLM Home…

(The HP SIM menu bar and VSE Management menu bar are discussed in the section “Tabs
and menus” (page 17).)

• gwlm command
A command-line interface, described in gwlm(1M) .
Other components of the command-line interface are: vseinitconfig(1M), gwlmcmsd(1M),
gwlmagent(1M), gwlmreport(1M), gwlmplace(1M), gwlmsend(1M), gwlmsslconfig(1M),
gwlmstatus(1M), and gwlmxml(4).

Assumptions
It is assumed that you have already installed the following software:
• HP Systems Insight Manager (SIM)
• HP VSE Management Software CMS
• gWLM agent on your managed nodes
For information about setting up HP SIM, see the documentation available at
http://www.hp.com/go/hpsim.
The following steps give an overview of the HP SIM installation process. When you install the
VSE Management Software and gWLM, you must do the following:
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1. Decide which system will be your central management server (CMS), then install the VSE
Management Software CMS on that system.
This system must also have HP SIM installed and running.

2. Initialize the CMS by running the vseinitconfig command.
For more information, see vseinitconfig(1M).

3. Decide which systems will be your managed nodes, then install the gWLM agent software
on those systems. (The agent software is free, but it is functional only for a limited time. For
unlimited use, purchase the agent license to use, or LTU.)

4. On each managed node, start the gWLM agent daemon gwlmagent.
You can perform the last two steps throughHP SIM, as described in theVSEManagement Software
Installation and Update Guide.

Finding more gWLM information
Table 1-2 indicates where you can find additional information.

Table 1-2 Where to find additional information

See...To...

VSE Management Page in HP SIM (Tools→Virtualization
Manager...)

View the structure (nPars, vPars, ...) of your
systems.

vseinitconfig(1M)Learn about configuring, backing up, and
maintaining your CMS.

gWLM Home Page in HP SIM (Tools→Virtualization Manager...,
then click the Shared Resource Domain tab, then Tools→Global
Workload Manager→Getting Started - gWLM Home...)
or
Global Workload Manager topic in online help1

or
HP Insight Global Workload Manager 6.2 User Guide (this document)
(http://www.hp.com/go/insightdynamics/docs)

Use gWLM immediately, reading as little as
possible.

Global Workload Manager topic in online help1

or
HP Insight Global Workload Manager 6.2 User Guide (this document)
(http://www.hp.com/go/insightdynamics/docs)

Learn about gWLM concepts.

“Concepts and terms for using gWLM” (page 8)
or
Glossary in online help1

Learn gWLM terms.

“Getting the Most Out of gWLM” topic in online help1Learn gWLM best practices.

HP Insight Global Workload Manager 6.2 User Guide (this document)
(http://www.hp.com/go/insightdynamics/docs)

Learn about other gWLM features.

Online help1Learn about the gWLM interface in HP SIM.

gwlm(1M)Learn about the gWLM command-line
interface.

gwlmcmsd(1M)Learn about gWLM daemons and services

Securing gWLM Communications topic in online help1

or
gwlmsslconfig(1M)

Learn about using secure communicationswith
gWLM.
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Table 1-2 Where to find additional information (continued)

See...To...

gwlmsend(1M)Learn how to update metrics when using
custom policies.

gwlmplace(1M)Learn how to manually place processes in
workloads based on psets or fss groups.

The HP Insight Dynamics - VSE documentation website at
http://www.hp.com/go/insightdynamics/docs

Learn about using gWLM with HP
Serviceguard.

• HP Insight Dynamics - VSE documentation website:
http://www.hp.com/go/insightdynamics/docs

• The HP Insight Dynamics - VSE for Integrity product website:
http://www.hp.com/go/insightdynamics/integrity

Learn more about nPars, vPars, virtual
machines, and psets.

The SEE ALSO section of gwlm(5) for a list of all gWLMmanpagesLearn about other gWLM commands.

1 To access online help in HP SIM, click Tools→Virtualization Manager..., then click the Shared Resource Domain
tab, and then click question mark (?) in the top right corner.
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2 Configuring gWLM to manage workloads
This chapter describes the various aspects of configuring gWLM to effectively manage the
resources for your workloads.

Policy types
You can define several types of policies to instruct gWLM how to manage the resources for your
workloads. These types are:
Fixed Allocates a fixed (constant) amount of CPU resources to a workload’s

compartment.
gWLM satisfies these policies before attempting to satisfy any other type of
policies.

Utilization Attempts to keep a workload’s CPU utilization close to a target percentage
by requesting more CPU resources when the workload is using too much of
its current CPU resource allocation or by requesting fewer resources when
the workload is using too little of its allocation. For example, assume a
workload has a utilization policy with a target of 80% and an allocation of 5
cores. If theworkload is consuming 4.5 cores, its utilization percentage is 4.5/5,
or 90%. gWLM would attempt to allocate additional CPU resources to the
workload’s compartment to meet the target. An allocation of 6 cores would
result in a utilization percentage of 4.5/6, or 75%, meeting the target.
With a utilization policy, you specify the minimum and maximum CPU
resource requests. Workloads with this type of policy are always allocated at
least the minimum request. Utilization policies allow you to prioritize
workloads.

OwnBorrow Allows you to set the following values:
• Amount of CPU resources, in cores, a workload’s compartment owns.
• Minimumamount of CPU resources, in cores, a workload’s compartment

must have (after lending resources to other workloads).
• Maximumamount of CPU resources, in cores, aworkload’s compartment

can have (after borrowing resources from other workloads).
The compartment of a workload with an OwnBorrow policy is allocated the
ownedCPU resourceswhen needed. Theminimumandmaximumsizes allow
you to specify how much the workload can lend (when resources are not
needed) or borrow (when additional resources are needed and available). If
a compartment has lent out cores and that compartment’s workload becomes
busy, the compartment re-acquires those lent-out cores.

Custom Available for advanced users. For information on custom policies, refer to the
online help or gwlmxml(4).

Conditional Specifies the existing policy to use when a time-based condition, a file-based
condition, or a Serviceguard condition is met.

You can define your own policies or use one of the numerous policies that come with gWLM.
You can use one policy for multiple workloads, minimizing the number of policies, if desired.
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Choosing a policy type
Howdo you decidewhich policy type to use? Table 2-1 answers this question for several common
use cases. The section following the table helps you decide between using an OwnBorrow policy
or a utilization policy.

Table 2-1 Choosing a policy type

Use the following type of policy...If...

FixedYou want gWLM to allocate a constant amount of CPU
resources to a workload.

CustomYou have your own metric by which you want gWLM to
manage a workload.

OwnBorrow
This policy type allows you to set an owned amount of
resources, while also giving you control over how
workloads borrow and lend resources.
gWLM provides a “topborrowers” report and a
“resourceaudit” report to help you manage your data
center using this model. For more information, see
gwlmreport(1M).

IT acts as a service provider to business units.

OwnBorrow
For each vPar, set its number of owned cores to its static
number of cores. The vPar gets those owned cores
whenever needed.

You have static vPars, but you want to move to a model
where cores migrate among vPars.

OwnBorrow
Install the HP Instant Capacity product on each npar.
(This software allows gWLM to simulate CPU resource
movement among nPars with spare capacity.)
For each npar, set its number of owned cores to the
number of cores you want the npar to have whenever
needed.

You have nPars but, you want to move to a model where
CPU resources migrate among nPars.

UtilizationYou want to tap into a pool of resources taking or giving
CPU resources as needed—with possibly no access to
resources beyond a minimum request.

Conditional
Select an existing policy and a default policy and then set
a time-based condition, set a file-based condition, or
choose from the possible Serviceguard conditions.

You have a policy that should be in effect only for a given
time period, for the duration of a file's existence, or for a
certain Serviceguard condition.

Choosing between an OwnBorrow policy and a utilization policy
OwnBorrowandutilization policies both allocate resources to aworkload based on theworkload's
use of its current allocation. Both policy types also specify minimum and maximum amounts of
resources theworkload should get. Aworkloadwith either type of policy can lend otherworkloads
its unused resources—down to its minimum. (If the workload does not consume its entire
minimum allocation, those unused resources are not available to other workloads.)
OwnBorrow policies, however, provide greater control in lending resources because they also
have an owned amount of resources. Aworkload always gets its owned resources backwhenever
needed. So, with an OwnBorrow policy, you can set a lower minimum allocation (increasing the
amount of resources available for sharing amongworkloads), knowing the associatedworkloads
get their owned resources whenever needed. Thus, an OwnBorrow policy provides greater
flexibility in attempting to allocate aworkload a certain amount of resourceswhen neededwhile
also lending those resources to other workloads when not needed.
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Combining the different policy types
Each workload in an SRD must have a policy. Starting with gWLM A.02.00.00.07, you can use
any combination of the policy types within an SRD.

Seeing how gWLM will perform without affecting the system
gWLMprovides an advisorymode that allows you to see howgWLMwill approximately respond
to a given SRD configuration—without putting gWLM in charge of your system’s resources.
Using this mode, you can safely gain a better understanding of how gWLMworks. In addition,
you can check that your policies behave as expected—with minimal effect on the system.
Advisory mode is not available for SRDs containing virtual machines, psets, or fss groups due
to the nature of these compartments.
Once you are comfortable with an SRD, change its mode to Managed to let gWLMmanage
resource allocation for the compartments in the SRD.
For information on changingmodes, refer to “Changing from advisorymode tomanagedmode”
(page 22).

Getting started with gWLM
gWLM is typically accessed through HP SIM. For information on the gWLM command-line
interface, see gwlm(1M).
After performing the necessary gWLM daemon (or service) configuration as described in the
VSEManagement Software Installation and Update Guide, the quickest way to start using gWLM to
manage new systems is to use the Manage Systems and Workloads wizard, as described in the
following text.
Before you start the wizard though, decide:
• Which systems you want to manage with gWLM
• Whether you want to manage your workloads by migrating CPU resources among nPars,

vPars, virtualmachines, processor sets, or fss groups. (CPU resourcemigration among nPars
with spare capacity is simulated using the HP Instant Capacity product, as explained in the
section “The gWLMmanagement model” (page 10).)

Tabs and menus
The controls shown in Figure 2-1 appear at the top of the Global Workload Manager screen.

Figure 2-1 Top controls of the Global Workload Manager screen

1

2

3

1 The SIM menu bar
2 The Virtualization Manager tabs
3 The VSE Management menu bar
These menu bars will be referenced later.

Using the wizard
To start the wizard:
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NOTE: Youmust be logged in as root on the systems where you run the mxstart, gwlmcmsd,
and gwlmagent commandsmentioned below. In HP SIM, youmust be logged in as root or have
authorizations for “All Tools” or “VSE All Tools.”

1. Configure your CMS as indicated in the VSE Management Software Installation and Update
Guide if you have not already done so

2. On each managed node, start the gWLM agent if it is not already running:
# /opt/gwlm/bin/gwlmagent

Alternatively, you can start the agent through HP SIM, as discussed in the VSEManagement
Software Installation and Update Guide.

3. Connect to HP SIM by pointing your web browser to:
http://hostname:280
where hostname represents the hostname of the CMS.

4. Select:
Tools→Virtualization Manager...

and then click the Shared Resource Domain tab. From the VSE Management menu bar,
select:
Create→Shared Resource Domain

The wizard guides you through the following steps:
1. Specify the hosts on which to run workloads that you want gWLM tomanage as part of one

SRD.
2. Set SRD properties.

Properties include the SRD name, mode, use of Temporary Instant Capacity (if available on
the system), and resource allocation interval.

3. Specify workload and policy settings.
Settings include the workload name and policy.

4. Review and confirm the SRD.
5. Verify the SRD is configured as expected, and click Finish to have gWLMmanage the

resource allocation for the workloads in the SRD.

Seeing gWLM in action
This section helps you see gWLMmove CPU resources among vPars. You can use similar steps
to see CPU resources move among nPars, virtual machines, psets, or fss groups. For psets and
fss groups, though, youwill need to put processes in the desired pset or fss group. (Place processes
by modifying the workload definition or by using the gwlmplace command.) In this example:
• The gWLM agent is used on two vPars, named vpar1 and vpar2.
• These vPars are idle and have a number of unbound cores that gWLM can move among

them.
• HP SIM and the gWLM CMS software are installed, configured, and running on a vPar

called vPar3.
To see gWLM in action:
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NOTE: Youmust be logged in as root on the systems where you run the mxstart, gwlmcmsd,
and gwlmagent commandsmentioned below. In HP SIM, youmust be logged in as root or have
authorizations for “All Tools” or “VSE All Tools.”

1. Start the gWLM agent daemons on vpar1 and vpar2:
# vpar1> /opt/gwlm/bin/gwlmagent

# vpar2> /opt/gwlm/bin/gwlmagent

Alternatively, you can start the agents throughHP SIM, as discussed in theVSEManagement
Software Installation and Update Guide.

2. Connect to HP SIM by pointing your web browser to:
http://hostname:280
where hostname represents the hostname of the CMS, in this case, vpar3.

3. Create a gWLM SRD containing the two vpars by following the steps given in “Getting
started with gWLM” (page 17).
a. For hosts, enter the names of the two vPars separated by a space in the field beneath

the table.
b. Ensure when setting the SRD properties that the mode is Managed.
c. Use an OwnBorrow policy for the vpar1 workload and for the vpar2 workload.

An OwnBorrow policy has a name of the form:
Owns_4-Max_8
Ideally, the sum of the cores owned by the workloads will equal the total number of
cores in the SRD when using this type of policy. (You might need to edit policies to
achieve this equality.)

d. Confirm and finish the SRD creation. (You are then placed on the Shared Resource
Domain View, showing the newly created SRD and its workloads.)

4. Select the vpar1 workload.
5. View gWLM’s real-time reports to show CPU resource allocation for vpar1 by selecting in

the VSE Management menu bar:
Report→gWLM Real-time Reports...

You can also view the reports by clicking the workload’s bar graph.

6. Click the Policy graph radio button to see a graph of vpar1’s CPU resource allocation.
7. Start a CPU resource-intensive workload in vpar1.

If you already have such a workload configured in vpar1, start it now.
If you need such a workload, the following command prints its PID (24379 in this case) and
then just consumes CPU resources:
# perl -e ’print "$$\n";while (1) {};’ &

[1] 24379

This command consumes most of a single core. Start multiple copies of the command to
consume additional cores.

8. Wait a fewminutes, then look at the “Policy Request andWorkload Allocation” graph from
Step 6 to see how the policy for vpar1’s workload is requesting CPU resource allocations
and how gWLM is granting them.

9. Kill the workloads you started in vpar1.
10. Set theWorkload dropdown near the top of the screen to the vpar2 workload and repeat

Step 7 through Step 9 to see gWLMmove cores to vpar2.
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Common uses for gWLM
gWLM is a powerful tool that allows you to manage your systems in numerous ways. The
following sections explain some of the more common tasks that gWLM can do for you.

Fixing the amount of CPU resources a workload gets
gWLM allows you to give a workload a fixed amount of CPU resources. This fixed amount is in
the form of a set amount of CPU resources given to an npar, a vpar, a virtual machine, a pset, or
an fss group.
To fix the amount of CPU resources a workload gets, use a fixed policy provided by gWLM or
create your own. Associate a fixed policy with a workload:
• When creating an SRD, as described in “Getting started with gWLM” (page 17)
• When adding aworkload to an SRD, as described in “Adding a new compartment or GiCAP

group member to an SRD” (page 24)
• By changing the policy associated with an existing workload, as described in “Changing

which policy is associated with a workload” (page 23)
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Resizing a workload’s npar, vpar, virtual machine, pset, or fss group as needed
To ensure a workload gets the CPU resources it needs—while also allowing resource sharing
when possible—gWLM provides OwnBorrow policies.
With such a policy, you indicate the amount of CPU resources a workload should own. The
workload is then allocated this owned amount of CPU resources—when it needs it. However,
you can configure the workload to:
• Lend CPU resources to other workloads when it is idle
• Borrow CPU resources from workloads that are idle
Associate an OwnBorrow policy with a workload:
• When creating an SRD, as described in “Getting started with gWLM” (page 17)
• When adding aworkload to an SRD, as described in “Adding a new compartment or GiCAP

group member to an SRD” (page 24)
• By changing the policy associated with an existing workload, as described in “Changing

which policy is associated with a workload” (page 23)
gWLM’s utilization policies also allow resizing.

Common configuration tasks
This section discusses various configuration tasks:
• “Changing from advisory mode to managed mode” (page 22)
• “Creating a new policy” (page 22)
• “Editing a policy” (page 23)
• “Changing which policy is associated with a workload” (page 23)
• “Adding a new compartment or GiCAP group member to an SRD” (page 24)
• “Stop managing a workload” (page 24)
• “Stop managing an SRD” (page 25)

Setting up gWLM (initial setup steps)
Several of the configuration tasks require the same initial set-up steps. (Each task requiring these
steps indicates that the steps are needed.) These steps are given below.

NOTE: Youmust be logged in as root on the systemswhere you run the gwlmagent command
mentioned below.

1. Configure your CMS as indicated in the VSE Management Software Installation and Update
Guide, if you have not already done so.

2. On each managed node, start the gWLM agent (if it is not already running):
# /opt/gwlm/bin/gwlmagent

Alternatively, you can start the agents throughHP SIM, as discussed in theVSEManagement
Software Installation and Update Guide.
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Changing from advisory mode to managed mode
Advisory mode allows you to see what CPU resource requests gWLM would make for a
workload—without actually affecting resource allocation. (Advisory mode is not available for
SRDs containing virtualmachines, psets, or fss groups due to the nature of these compartments.)
Managed mode, however, allows gWLM to automatically adjust the resource allocations for
your defined workloads.
To change from one mode to the other:

NOTE: In HP SIM, you must be logged in as root or have authorizations for “All Tools” or
“VSE All Tools.”

NOTE: If you are changing from managed mode to advisory mode and you do not plan to
change back soon, be aware that gWLM leaves the npar and vpar and pset compartments with
the number of cores they had in the last allocation interval. Set the compartments to your desired
sizes before changing to advisory mode by associating fixed policies with all the compartments
and waiting for an allocation interval to pass.

1. Ensure HP SIM, the gWLM CMS daemon or service (gwlmcmsd) and all the gWLM agents
(gwlmagent) are still running, as explained in the section “Setting up gWLM (initial setup
steps)” (page 21).

2. Connect to HP SIM by pointing your web browser to:
http://hostname:280
where hostname represents the hostname of the CMS.

3. From the HP SIM menu bar, select:
Tools→Virtualization Manager...

and then click the Shared Resource Domain tab.

4. Select the SRD for which to change the mode.
5. From the VSE Management menu bar, select:

Modify→Shared Resource Domain

6. Change to the desired mode.
7. ClickOK.

Quick Link Options

In the previous procedure, instead of selecting an SRD and using the VSE Management menu
bar, you can find the Details table for the SRD and then choose one of the following options:
• Click the Change SRD to advisory mode link
• Click theModify SRD link

Creating a new policy
A policy instructs gWLM how to manage a workload’s resources. You can create a policy when
managing a workload or create a policy separately. To create a policy separately:

NOTE: In HP SIM, you must be logged in as root or have authorizations for “All Tools” or
“VSE All Tools.”

1. Ensure HP SIM, the gWLM CMS daemon or service (gwlmcmsd) and all the gWLM agents
(gwlmagent) are still running, as explained in the section “Setting up gWLM (initial setup
steps)” (page 21).

2. Connect to HP SIM by pointing your web browser to:
http://hostname:280
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where hostname represents the hostname of the CMS.

3. From the HP SIM menu bar, select:
Tools→Virtualization Manager...

and then click the Shared Resource Domain tab.

4. From the VSE Management menu bar, select:
Policy→Create gWLM Policy...

5. Edit the settings, selecting a policy type and specifying the required values and optional
values as desired.

6. ClickOK.

Editing a policy
A policy instructs gWLM how to manage a workload’s resources.

NOTE: You can edit the policies provided with gWLM; however, there is currently no way to
restore these policies to their original definitions.

To edit a policy:

NOTE: In HP SIM, you must be logged in as root or have authorizations for “All Tools” or
“VSE All Tools.”

1. Ensure HP SIM, the gWLMCMS daemon or service (gwlmcmsd), and all the gWLM agents
(gwlmagent) are still running, as explained in the section “Setting up gWLM (initial setup
steps)” (page 21).

2. Connect to HP SIM by pointing your web browser to:
http://hostname:280
where hostname represents the hostname of the CMS.

3. From the HP SIM menu bar, select:
Tools→Virtualization Manager...

4. From the VSE Management menu bar, select:
Policy→Edit gWLM Policies...

5. Select the policy to edit.
6. Click Edit.
7. Edit the settings.
8. ClickOK.

NOTE: Allworkloads associatedwith this policywill automatically use the updated policy.

Changing which policy is associated with a workload
To change the policy affecting how gWLM allocates resources to a workload:

NOTE: In HP SIM, you must be logged in as root or have authorizations for “All Tools” or
“VSE All Tools.”

1. Ensure HP SIM, the gWLM CMS daemon or service (gwlmcmsd) and all the gWLM agents
(gwlmagent) are still running, as explained in the section “Setting up gWLM (initial setup
steps)” (page 21).
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2. Connect to HP SIM by pointing your web browser to:
http://hostname:280
where hostname represents the hostname of the CMS.

3. From the HP SIM menu bar, select:
Tools→Virtualization Manager...

and then click the Shared Resource Domain tab.

4. Select the shared resource domain containing the workload for which you want to change
the policy.

5. Select the workload for which you want to change the policy.
6. From the VSE Management menu bar, select:

Policy→Change Associated gWLM Policy...

7. From the Policy dropdown in the table row for the workload, select the new policy to
associate, or apply, to the workload.

8. ClickOK.

Adding a new compartment or GiCAP group member to an SRD
If you:
• Have added an npar, a vpar, or a virtual machine to your system and want to add it to an

SRD,
• Have added a Global Instant Capacity (GiCAP) group member and want to add it to an

SRD, or
• Want to create psets or fss groups in a host already in an SRD
You can use the gWLM wizard to accomplish those tasks. To start the wizard, select from the
HP SIM menu bar:
Tools→Virtualization Manager...

and then click the Shared Resource Domain tab. From the VSE Management menu bar, select:
Create→Shared Resource Domain

Step 1 in the wizard allows you to add nPars, vPars, and GiCAP group members. Step 3 allows
you to create psets or fss groups, as well as manage existing virtual machines.

Stop managing a workload
When you stop managing a workload:
• gWLM stops managing resources for the workload
• Theworkload’s definition is removed from the SRD, although it remains available for placing

in another SRD

NOTE: When gWLM stops managing npar-based or vpar-based workloads, it leaves the nPars
or vPars with the number of cores they had in the last allocation interval. For this reason, in Step
3 below, you associate fixed policies with the workloads based on these types of compartments.
You must stop a virtual machine before you stop managing it with gWLM. When gWLM stops
managing a virtualmachine, it sets the entitlement of the running virtualmachine to itsminimum.
For psets and fss groups, gWLM removes the pset or fss group and moves the processes from
that compartment to the default compartment.

To stop managing workloads in an SRD:
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1. Ensure HP SIM, the gWLMCMS daemon or service (gwlmcmsd), and all the gWLM agents
(gwlmagent) are still running, as explained in the section “Setting up gWLM (initial setup
steps)” (page 21).

2. Connect to HP SIM by pointing your web browser to:
http://hostname:280
where hostname represents the hostname of the CMS.

3. Associate fixed policies with all workloads that you want to unmanage that are based on
nPars or vPars.
For information on setting the associated policy, refer to “Changingwhich policy is associated
with a workload” (page 23).

4. Wait an allocation interval for gWLM to set CPU resource allocations based on the fixed
policies.

5. Click the Shared Resource Domain tab.
6. Select the workload you want to stop managing in the workload table.
7. From the VSE Management menu bar, select:

Policy→Remove Associated gWLM Policy...

8. Associate policies.
Evaluate and change, if needed, the remaining workloads and their associated policies to
ensure they are appropriate, given that a workload has been removed.

9. ClickOK.

Stop managing an SRD
To stop gWLMfrommanaging an SRDand itsworkloads, returning resource allocation toHP-UX:

NOTE: In HP SIM, you must be logged in as root or have authorizations for “All Tools” or
“VSE All Tools.”

1. Ensure HP SIM, the gWLMCMS daemon or service (gwlmcmsd), and all the gWLM agents
(gwlmagent) are still running, as explained in the section “Setting up gWLM (initial setup
steps)” (page 21).

2. Connect to HP SIM by pointing your web browser to:
http://hostname:280
where hostname represents the hostname of the CMS.

3. Associate fixed policies with all nPars or vPars that were in the SRD.
When gWLM stops managing an SRD, it leaves compartments based on nPars or vPars as
they were in the last allocation interval. Associating fixed policies allows you to set the sizes
exactly to what youwant. (For virtual machines, gWLM sets the entitlements of the running
virtual machines to their minimums. psets and fss groups are removed in this situation,
with their processes going to the default pset or default fss group.)
For information on setting the associated policy, refer to “Changingwhich policy is associated
with a workload” (page 23)

4. Click the Shared Resource Domain tab.
5. Select the SRD that you want to stop managing (undeploy).
6. From the VSE Management menu bar, select:

Modify→Shared Resource Domain

7. Change to the Undeployed state.
8. ClickOK.
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Quick Link Option

In the previous procedure, instead of selecting an SRD and using the VSE Management menu
bar, you can find the Details table for the SRD and click the Undeploy SRD link.
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3 Monitoring workloads and gWLM
This chapter describes how to monitor workloads and gWLM.

Monitoring workloads
There are several methods for monitoring workloads, as described below.

High-Level view
To see a high-level view of the performance of your SRDs and workloads:
1. From the HP SIM menu bar, select:

Tools→Virtualization Manager...

2. Click the Shared Resource Domain tab.

Graphical reports
gWLM provides graphs showing either real-time or historical data through HP SIM. For
information on interpreting these reports, refer to the online help.

Real-time reports
To view real-time reports:
1. From the HP SIM menu bar, select:

Tools→Virtualization Manager...

2. Click the Shared Resource Domain tab.
3. Select a workload.
4. From the VSE Management menu bar, select:

Report→gWLM Real-time Reports...

Quick link option

In the previous procedure, instead of selecting aworkload and using the VSEManagementmenu
bar, you can click the workload's “CPU Utilization” bar graph.

Historical reports
To view historical reports:
1. From the HP SIM menu bar, select:

Tools→Virtualization Manager...

2. Click the Shared Resource Domain tab.
3. From the VSE Management menu bar, select:

Report→gWLM Historical Reports…

Viewing gWLM reports in monitor-Only mode
gWLMallows you to specify userswho should be allowed only tomonitor gWLM reports. These
users do not have the ability to change gWLMconfigurations. To set up a userwithmonitor-only
privileges, refer to the online help topic “Authorizations and Read-only Monitoring.”
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Monitoring gWLM from the command line
There are several command-line tools for monitoring gWLM. These commands are added to the
path during installation. On HP-UX systems, the commands are in /opt/gwlm/bin/. On
MicrosoftWindows systems, the commands are inC:\Program Files\HP\Virtual Server
Environment\bin\gwlm\ by default. However, a different path might have been selected at
installation.

NOTE: You must be logged in as root on HP-UX or into an account that is a member of the
Administrators group on Windows to run the commands below.

• gwlm monitor

The gwlm command, available only on a CMS, has a monitor subcommand that displays
policy, workload, and SRD statistics.

• gwlmreport

This command, available only on aCMS, provides various types of reports: topborrowers,
resourceaudit,abnormalutil, andextract (which provides data in comma-separated
values for use in other tools). It also provides an ovpafeed option that extracts data for use
with OpenView Performance Agent via data source integration (DSI). In addition, it can
generate a config report showing the history of configuration changes.

• gwlmstatus

The gwlmstatus command, available only onmanaged nodes, displays status information
for a managed node's agent and SRD. The information displayed includes:
— Whether gwlmagent is running
— The version of the installed gwlmagent
— The SRD to which the current node belongs (if a member of a deployed SRD)
— Master node of the deployed SRD
— Whether hosts in the SRD are nonresponsive
— Whether the host's SRD is themost recently deployed SRDon the CMS (This knowledge

can be useful in determining failed deployments.)
— Whether any hosts are unable to rejoin the SRD

For more information, see gwlm(1M), gwlmreport(1M), or gwlmstatus(1M).

Message logs
Formessages about gWLM’s ongoing operations, gWLM logs error and informationalmessages,
as well as statistics, to one of several log files:

Table 3-1 gWLM log files

LocationLog for

HP-UX: /var/opt/gwlm/gwlmcmsd.log.0
Windows: C:\Program Files\HP\Virtual Server
Environment\logs\gwlmcmsd.log.0

gwlmcmsd daemon or service

HP-UX: /var/opt/gwlm/gwlmagent.log.0
Windows: Not applicable

gwlmagent daemon
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Table 3-1 gWLM log files (continued)

LocationLog for

HP-UX: /var/opt/gwlm/gwlm.log.0
Windows: C:\Program Files\HP\Virtual Server
Environment\logs\gwlm.log.0

gWLM interface in HP Systems Insight
Manager

HP-UX: /var/opt/gwlm/gwlmcommand.log.0
Windows: C:\Program Files\HP\Virtual Server
Environment\logs\gwlmcommand.log.0

gwlm command

NOTE: On systems running Windows, log files are in C:\Program Files\HP\Virtual Server
Environment\logs\ by default. However, a different pathmight have been selected at installation.

The name of the current log always ends in .log.0. Once this file grows to a certain size, it is
moved to a filename ending in .log.1 and a new .log.0 file is started. If a .log.1 file already exists,
it is renamed .log.2. If a .log.2 file already exists, it is overwritten.
By default, the log file size is limited to 20Mbytes and the number of log files is limited to 3. You
can change these defaults using the following properties:
com.hp.gwlm.util.Log.logFileSize = 20

com.hp.gwlm.util.Log.logNFiles = 3

For the gwlmagent log, change the values of these properties in /etc/opt/gwlm/conf/
gwlmagent.properties. For all the other log files, change the values in /etc/opt/gwlm/
conf/gwlmcms.properties onHP-UX and in C:\Program Files\HP\Virtual Server
Environment\conf\gwlmcms.properties on Windows. (The given Windows path is the
default; however, a different path might have been selected at installation.)
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Viewing HP Systems Insight Manager events
gWLM allows you to configure a number of events you can monitor through HP SIM. Set these
events in HP SIM as follows:
1. From the HP SIM menu bar, select:

Tools→Virtualization Manager...

2. Click the Shared Resource Domain tab.
3. From the VSE Management menu bar, select:

Tools→Global Workload Manager→Events…

After configuring these events, you can monitor them through the various Events items in the
left pane of HP SIM. Also, the Shared Resource Domain View provides links to any uncleared
gWLM events, filtering out all other events.

Monitoring gWLM with GlancePlus
You canuseHP’s optional performance andmonitoring toolGlancePlus to viewdata onworkloads
based on fss groups that are managed by gWLM. (Use GlancePlus C.03.35.00 or later. Also, you
must have the bundle PRMLibraries C.03.03 or later installed. This bundle is available from
http://www.hp.com/go/softwaredepot.)
GlancePlus has both a text interface (glance) and an X-Windows interface (gpm).
Items to be aware of when using GlancePlus:
• Data is displayed only for workloads based on fss groups. Data for the workload with FSS

ID 0 is shown without a name.
• gWLM workloads are referred to as “PRM Groups” in GlancePlus.
• Theworkload names displayed byGlancePlusmight vary slightly from those used in gWLM

due to differences in characters allowed in names.
• GlancePlus data is in terms of shares percentages of CPU resources, whereas gWLM data

is in terms of physical cores.
• GlancePlus and gWLM use different methods for gathering resource utilization, so data

between the products does not always match.
• Data is not displayed for more than 64 workloads.
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4 Security
This chapter highlights several security items you should be aware of.

General security topics
The following items are a few general topics on security:
• HPprovides theHP-UXBastille product, available fromhttp://software.hp.com at no charge,

for enhancing system security.
• You can secure gWLM’s communications as explained in the following section.
• HP SIM allows you to create user roles with different levels of privileges. For more

information, see the HP SIM documentation.
For information on authorizations needed to run the VSE Management Software, see the
VSE Management Software Version 4.0 Getting Started Guide or the online help topic
“Authorizations and Read-only Monitoring.”

Securing gWLM communications
By default, gWLM’s communications are not secure, meaning:
• The communications between the CMS and the managed nodes are not encrypted
• The source and destination of gWLM’s communications are not authenticated
When securing communications, youmust do so for everymanagednode in every SRDmanaged
by a given CMS.
To secure gWLM’s communications, assuming OpenSSH is installed and configured for HP SIM
on each of the managed nodes, select from the HP SIM menu bar:
Configure→Configure VSE Agents→Secure gWLM Communications…

For more information, see the online help topic “Securing gWLM Communications.”
Alternatively, you can secure communications manually by following the steps outlined in
gwlmsslconfig(1M).

NOTE: HP strongly recommends always using gWLM with its communications secured.

Securing database communications
The following sections explain how to secure communications for the databases supported with
gWLM.

Securing Postgres communications
No steps are needed to secure Postgres communications.

Securing Oracle communications
Oracle communications are not secure by default in the HP-UX environment. To secure
communications:

NOTE: This procedures affects gWLM, HP Capacity Advisor, and HP Virtualization Manager
as they all communicate with the Oracle database in the same manner.

1. Open /etc/opt/gwlm/conf/gwlmcms.properties in a text editor.
2. Set the property com.hp.gwlm.jdbc.oracle.secure to 'on'.
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3. Set the following properties as desired:
• oracle.net.encryption_types_client

• oracle.net.crypto_checksum_types_client

For more information on these properties, read their associated comments in the
gwlmcms.properties file.

4. Ensure the Oracle listener and port being used by HP SIM is configured to accept secure
communication for the encryption and checksum types specified in the previous step.

5. TheOracle database administrator can use netmgr to configure settings on theOracle server.
6. Restart the gWLM CMS daemon (/opt/gwlm/bin/gwlmcmsd)
To disable secure Oracle communications:
1. Open /etc/opt/gwlm/conf/gwlmcms.properties in a text editor.
2. Set the property com.hp.gwlm.jdbc.oracle.secure to 'off'.
3. Restart the gWLM CMS daemon (/opt/gwlm/bin/gwlmcmsd)
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5 Additional configuration and administration tasks
This chapter covers various configuration and administration tasks.

Manually adjusting CPU resources
When an SRD is created, it has a certain number of cores. gWLMmanages the SRD using the
same number of cores. If the SRD—or a policy used in the SRD—is configured to use Temporary
Instant Capacity (TiCAP), gWLM can automatically activate that additional capacity to meet
policies. If neither the SRD or its policies are configured to use TiCAP, you may be able to
temporarily provide additional resources to a deployed SRD by:
• Using an available core from the vpar monitor free pool.
• Activating an iCAP core.
• Deleting a core from an unmanaged vpar and then adding it to a vpar in the SRD.
• Deactivating a core in an npar and then activating one in an npar in the SRD.

NOTE: If gWLM detects activated cores for which there is no request, it deactivates them to
avoid spending money on the unneeded capacity.

NOTE: After you manually change system resources (by modifying unmanaged partitions or
changing bindings, for example), you might see resize errors on one or more of the managed
nodes. However, gWLM should recover (and stop issuing errors) by the next resource allocation
interval—unless gWLM can no longer access the required resources.

NOTE: Deployed SRDs do not accept manual decreases in the available resources. gWLMwill
attempt to reclaim any removed resources.

NOTE: Although a deployed SRD might recognize added resources, policy maximum values
are still in effect and can clip resource requests. Consider adjusting policy settings to use the
added resources.

As already mentioned, gWLM can take advantage of the additional CPU resources only
temporarily. To take full, persistent advantage of the extra resources using the gWLM interface
in HP SIM:
1. Modify the size of the SRD.

a. Select the SRD affected by the additional resources in the Shared Resource Domain
View.

b. Select the menu item Modify→Shared Resource Domain.
c. Click theWorkload and Policies tab.
d. Adjust the size of the SRD by editing the value, beneath the table, labeled “Total Size.”
e. Click OK.

2. Edit policies used in the SRD to ensure they do not unintentionally limit their associated
workloads' resource requests.

To take full, persistent advantage of the extra resources using the gWLMcommand-line interface:
1. Undeploy the SRD containing the systems that were adjusted.
2. Re-create and re-deploy the SRD.
3. Ensure policies used in the SRD do not unintentionally limit their associated workloads'

resource requests.
gWLM cannot take advantage—even temporarily—of resources added by:
• Adjustments to entitlements for virtual machines.
• Changes to a virtualmachine's number of virtual CPUswhile gWLM ismanaging the virtual

machine.

Manually adjusting CPU resources 33



• Creation or deletion of a pset using psrset on a system where gWLM is managing pset
compartments.

• Performing online cell operations using parolrad.
• Enabling and disabling Hyper-Threading.
To make use of these additional resources using the gWLM command-line interface:
1. Undeploy the SRD containing the systems that you want to adjust.
2. Make your adjustments.
3. Re-create and re-deploy the SRD.
4. Ensure policies used in the SRD do not unintentionally limit their associated workloads'

resource requests.
To make use of these additional resources using the gWLM interface in HP SIM, follow the
procedure given for that interface above.

NOTE: After manually adjusting the number of cores in an SRD, always confirm the changes
after two gWLM resource allocation intervals have passed. Changes might not be as expected
due to gWLM behaviors such as the ones described below.
• In an SRD with nested partitions, gWLM samples the inner partitions for their sizes before

sampling the outer partitions. Adjusting resources between these samplings can cause gWLM
to report incorrect sizes. If you encounter this issue, try making your adjustment again.

• In an SRDwith nested partitions that includes vPars, assume you manually add cores from
an unmanaged vpar. If you later remove those cores—without returning them to an
unmanaged vpar before gWLM samples compartment sizes—those cores are deactivated.

Manually adjusting memory resources
The vparmodify command enables you to move memory from one vpar to another. However,
gWLM cannot move CPU resources while a vparmodify operation is in progress. If a memory
move takes longer than gWLM's resource allocation interval, gWLM will not be able to satisfy
CPU resource requests for the missed intervals. gWLM resumes allocating resources once the
memory move is complete.
You might see SIM events indicating vparmodify commands executed by gWLM are failing.
The vparmodify commands fail with the following message:
A conflicting resource migration is in progress on this vPar.

Once the pending migration completes, the gWLM operation should complete.

Setting aside space for historical data
HP recommends that you allocate 4 GB of storage for every 100workloads youwill managewith
gWLM. With a 5-minute sampling interval, this is enough space to store 2 years of data, which
you can then use for capacity planning and performance management.
On HP-UX, the provided HP System Management Database (HPSMDB), also known as
PostgreSQL, stores its data in the /var/opt/ file system. On HP-UX and Windows systems
using Oracle, set aside the space in the file system used by the configured database.

Backing up the VSE Management Software database

NOTE: This section applies only to the providedHP SystemManagementDatabase (HPSMDB).

The VSE Management Software database contains configuration data as well as historical
performance data. To create a backup of your gWLM database, use the vseinitconfig
--backup command . To make use of a backup file, use the vseinitconfig --restore
command.
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For more information, see vseinitconfig(1M).

Tips for backup and restore
Here are tips to make the best use of backup and restore:
• To ensure the latest gWLM data is backed up, issue the following command before using

the --backup option:
gwlm history --flush

• If the CMS or the managed nodes have been modified (such as changes in number of cores
or hostnames) between a backup and a restore or you are trying to do a restore on a different
CMS, gWLM will probably not function as expected after the restore.

Setting gWLM properties
gWLM provides two properties files that allow you to control various gWLM behaviors. One
file is for the CMS daemon or service, and the other is for use on all the managed nodes. Read
the files for information on the behaviors they control.

CMS properties
The CMS properties are in /etc/opt/gwlm/conf/gwlmcms.properties on HP-UX and in
C:\Program Files\HP\Virtual Server Environment\conf\gwlmcms.properties
on Windows. (The given Windows path is the default; however, a different path might have
been selected at installation.)

NOTE: Some values are read by gWLM only when a daemon or service is started; while other
values are read when an SRD is deployed. Refer to the file for information on when individual
properties are read.
Restartinggwlmcmsd temporarily disablesHPVirtualizationManager andHPCapacityAdvisor.

The gwlmcms.properties file is shown below.
#
# (C) Copyright 2004-2008 Hewlett-Packard Development Company, L.P.
#
# $Date: 2008/12/02 20:17:18 $
# $Revision: 1.1 $
#
# Contents:
# This file contains the default configuration values for the
# Global Workload Manager CMS.
#
# You must restart gwlmcmsd for changes made to this file
# to take effect--unless otherwise noted.
#

#
# Set FileHandler log level for the following log files:
#       /var/opt/gwlm/gwlmcmsd.log.0
#       /var/opt/gwlm/gwlmcommand.log.0
#       /var/opt/gwlm/gwlm.log.0
#       /var/opt/vse/logs/gwlminitconfig.log.0
# Valid levels, from most severe to least, are:
#       SEVERE
#       WARNING
#       INFO
#       CONFIG
#       FINE
#       FINER
#       FINEST
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# When you set the level, you will see messages only from that level and
# the levels that are more severe. So, the SEVERE level produces the fewest
# messages, while the FINEST level includes messages from all seven levels.
#
com.hp.gwlm.util.Log.logLevel = INFO

#
# Specify the size (in MB) and number of files to use  
# for logging. For a single file of unlimited size, set
# logFileSize to negative one (logFileSize=-1).
# Otherwise, total log file size is
#    logFileSize * logNFiles
#
com.hp.gwlm.util.Log.logFileSize = 20
com.hp.gwlm.util.Log.logNFiles = 3

#
# Support for automatic database statistics gathering.  These properties
# control how often row-level statistics are gathered from the database in
# order to optimize performance.
#
#   com.hp.gwlm.cms.db.analyze.time:
#       Frequency, in minutes, in which statistics are gathered.  The
#       default is to attempt to gather database statistics every 60
#       minutes.  When the analysis runs, statistics will only be gathered
#       if a certain number of transactions  have been processed (which is
#       configured in the property below).
#
#   com.hp.gwlm.cms.db.analyze.limit:
#       Number of consecutive transactions that must take place before a
#       database analysis is performed.
#
com.hp.gwlm.cms.db.analyze.time  = 60
com.hp.gwlm.cms.db.analyze.limit = 50

#
# Support for the database cache on the CMS.
#
#   cachesize:
# The number of historical configurations to cache in memory.
# A larger historical configuration cache reduces time spent
# in database lookups.  The valid range is 1-1000.
#
com.hp.gwlm.cms.cachesize = 100

#
# Support for local data caching on a remote node for report generation.
# These properties are defined on the CMS but are pushed out to the remote
# node managers during deployment of an SRD.  The cached objects on the
# agent consume an amount of memory approximated by:
#
#    Memory = 5000 * workloads * cachesize * (60 / resource_domain_interval)
#
# bytes of memory.  For example, if there are 4 workloads deployed with a
# 15 second interval and a cachesize of 20 minutes, the agent will need:
#
#    Memory = 5000 * 4 * 20 * (60 / 15) ~ 2.5 MB.
#
#   cachesize:
#       The number of minutes of real-time data to maintain on the remote
# node for future CMS access.  This value must be at least three
# times the 'samples' value specified below.  The default value is
#       20 minutes.
#
#   samples:
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# The number of minutes of real-time data used to aggregate into a
# historical data point. The default is to aggregate the data into
# 5-minute averages.
#
com.hp.gwlm.node.cachesize = 20
com.hp.gwlm.node.samples   = 5

#
# Support for real-time graphing properties.
#
#   viewport:
#       The size of the displayed real-time graph (in minutes).
#
#   refresh:
#       The refresh rate of the real-time graphs and tables (in seconds).
#
com.hp.gwlm.ui.monitor.viewport = 20
com.hp.gwlm.ui.monitor.refresh  = 15

#
# Support for securing Oracle communication.
#
#  com.hp.gwlm.jdbc.oracle.secure:
#  Whether communication with Oracle server is secure or not. Possible
# values are 'on' and 'off'. Default is off.
#
#  oracle.net.encryption_types_client:
# Secure communication encryption type. Possible values are RC4_256,
# RC4_128, RC4_56, RC4_40, 3DES112, 3DES168. See Oracle documentation
# for details.  
#
#  oracle.net.crypto_checksum_types_client:
#   Encryption type for Oracle secure communication integrity checking.
#
#  Make sure that the parameter values specified here match those on
#  the Oracle server.
#
com.hp.gwlm.jdbc.oracle.secure = off
oracle.net.encryption_types_client = 3DES112
oracle.net.crypto_checksum_types_client = MD5

Agent properties
The agent properties are in /etc/opt/gwlm/conf/gwlmagent.properties onHP-UX and
in C:\Program Files\HP\Virtual Server Environment\conf\
gwlmagent.properties on Windows. (The given Windows path is the default; however, a
different path might have been selected at installation.)

NOTE: You must restart the gwlmagent daemon on each managed node where you have
modified the properties file for the changes to the file to take effect.

The gwlmagent.properties file is shown below.
#
# (C) Copyright 2004-2007 Hewlett-Packard Development Company, L.P.
#
# $Date: 2008/12/02 20:17:18 $
# $Revision: 1.1 $
#
# Contents:
# This file contains the default configuration values for the
# Global Workload Manager Agent on a given managed node. The
# agent on each managed node uses the default values unless you
# edit that node's gwlmagent.properties file.
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#
# You must restart gwlmagent for changes made to this file to
# take effect.
#

#
# Set FileHandler /var/opt/gwlm/gwlmagent.log.0 log level.
# Valid levels, from most severe to least, are:
# SEVERE
# WARNING
# INFO
# CONFIG
# FINE
# FINER
# FINEST
# When you set the level, you will see messages only from that level and
# the levels that are more severe. So, the SEVERE level produces the fewest
# messages, while the FINEST level includes messages from all seven levels.
#
com.hp.gwlm.util.Log.logLevel = INFO

#
# Specify the size (in MB) and number of files to use  
# for logging. For a single file of unlimited size, set
# logFileSize to negative one (logFileSize=-1).
# Otherwise, total log file size is
#    logFileSize * logNFiles
#
com.hp.gwlm.util.Log.logFileSize = 20
com.hp.gwlm.util.Log.logNFiles = 3

#
# Set the number of seconds for the high availability (HA) minimum
# timeout. Communication is considered lost on a managed node
# once the timeout period has elapsed.
#
# By default, communication is not considered lost until 10 allocation
# intervals have elapsed without communication. The default value of the
# property (60) is used only when the allocation interval is less than 6
# seconds.  
#
com.hp.gwlm.node.HA.minimumTimeout = 60

#
# Enable/disable use of Instant Capacity (iCAP) to simulate movement of
# cores across nPartitions. To use iCAP, you must enable this property on 
# each managed nPartition where you want to take advantage of iCAP. Also, 
# each nPartition must meet the requirements outlined in the online help 
# topic "Getting the most out of gWLM" as well as in the section "USING 
# nPars AS COMPARTMENTS IN AN SRD" in the gwlmxml(4) man page on HP-UX or 
# the gwlmxml(5) man page on Linux.
#
com.hp.gwlm.platform.icap.manageWithIcap = on

#
# Set the minimum number of Temporary Instant Capacity (TiCAP) minutes
# that must be available for TiCAP activation.  gWLM will stop using
# TiCAP when the available balance goes below this threshold.  The
# same value should be set on all agents managing the SRD.  To use
# TiCAP, it must be available on the complex and enabled at the policy
# level or the SRD level.
#
com.hp.gwlm.node.ticap.minimumBalance = 30
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Communications ports
gWLM uses the following ports for communications:
Managed nodes: 9617
CMS: 9618
If you need to change these ports, add the following lines:
com.hp.gwlm.cms.port = portX

com.hp.gwlm.node.port = portY

to both properties files:
• gwlmcms.properties

On HP-UX, this file is in /etc/opt/gwlm/conf/. On Windows, it is in C:\
Program Files\HP\Virtual Server Environment\conf\. (The given Windows
path is the default; however, a different path might have been selected at installation.)

• /etc/opt/gwlm/conf/gwlmagent.properties

The portX and portY values cannot be the same value.
The com.hp.gwlm.cms.port property must have the same portX value in all the properties
files—across all managed nodes and on the CMS. Similarly, the com.hp.gwlm.node.port
property must have the same portY value in all the properties files—across all managed nodes
and on the CMS.
You must restart gwlmcmsd and gwlmagent for the changes to take effect. If you are using
gWLM through HP SIM, you must also restart SIM. (On HP-UX, restart SIM daemons using
/opt/mx/bin/mxstop and mxstart. On Windows, restart the HP Systems Insight Manager
service.)

NOTE: Restarting gwlmcmsd temporarily disables HP Virtualization Manager and
HP Capacity Advisor.

Controlling gWLM’s startup behavior
The gWLM CMS daemon or service (gwlmcmsd) is set to start at boot by vseinitconfig.
Generally, you should not change this setting as it disables all VSE Management Software from
starting at boot.
OnHP-UX, you can controlwhether the gWLMCMSdaemon (gwlmcmsd) and its agent daemons
on the managed nodes (gwlmagent) start at boot by:
• Manually setting variables in the/etc/rc.config.d/gwlmCtl file. (The/sbin/init.d/

gwlmcmsd and /sbin/init.d/gwlmagt scripts use these variables.)
• Using the --enable_start_on_boot and --disable_start_on_boot options to

gwlmcmsd and gwlmagent.
OnWindows, to controlwhether the gWLMCMSdaemon (gwlmcmsd) starts at boot: Right-click
theMy Computer icon, clickManage, double-click Services & Applications, double-click
Services, right-clickHP Global Workload Manager Central Management Server, select
Properties, and change the Startup type to the desired setting.

NOTE: HP recommends starting these daemons at boot only when used in a secure operating
environment.
SettingGWLM_CMS_START to 0 (zero) prevents automatic use at boot ofHPVirtualizationManager
and HP Capacity Advisor.

The gwlmCtl file is shown below:
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########################################################################
# (C) Copyright 2004-2008 Hewlett-Packard Development Company, L.P.
#
# gWLM Configuration File
#
# $Revision: 1.1 $
# $Date: 2008/12/02 20:17:18 $
########################################################################

# Set GWLM_CMS_START to 1 to have the init process start the gWLM CMS
# daemon. (HP recommends setting this variable to 1 only when used in a
# secure operating environment.)
#
# NOTE: GWLM_CMS_START=0 prevents automatic use at boot of 
#       HP Virtualization Manager and 
#       HP Capacity Advisor.
GWLM_CMS_START=0

# Set GWLM_AGENT_START to 1 to have the init process start the gWLM agent
# daemon. (HP recommends setting this variable to 1 only when used in a
# secure operating environment.)
GWLM_AGENT_START=0

# Set GWLM_HOME to the location where gWLM is installed.
# Default is /opt/gwlm.
GWLM_HOME=/opt/gwlm

Automatic restart of gWLM’s managed nodes in SRDs (high availability)
Whenever a managed node boots, the node’s gWLM agent attempts to automatically rejoin the
node in its SRD, providing high availability. The only configuration steps you need to perform
for this behavior to happen are:
1. Ensure the /etc/rc.config.d/gwlmCtl file on each managed node has

GWLM_AGENT_START set to 1. You can run the following command on each system where
gwlmagent is running to make this change for you:
# /opt/gwlm/bin/gwlmagent --enable_start_on_boot

In the same file, you also need GWLM_CMS_START=1 on the system where gwlmcmsd is
running. However, when you ran vseinitconfig during installation, this change was
automatically made.

2. (Optional) Edit the property
com.hp.gwlm.node.HA.minimumTimeout

in the file/etc/opt/gwlm/conf/gwlmagent.properties to set theminimumnumber
of seconds that must pass before a managed node considers itself separated from its SRD.
Set this property to ensure that minor network problems do not cause a managed node to
prematurely consider itself separated.
gWLM uses this value only if it is larger than 10 multiplied by gWLM’s allocation interval.
For example, with an allocation interval of 15 seconds, a node can go 2.5 minutes without
communicating with its SRD before the node’s gWLM agent attempts to re-connect with
the SRD.

This feature works best when one managed node is lost at a time or all managed nodes are lost.

40 Additional configuration and administration tasks



NOTE: If a vpar is borrowing cores from other vPars when it loses contact with its SRD, those
borrowed cores might be separated from the SRD. If the vpar might be down for an extended
time, check that the SRD has reformed without that vpar and that it has enough cores to meet
its commitments. If not, try using vparmodify to reclaim some of the cores. (With the vpar
down, youwill not be able tomodify it locally, and only some versions ofHP-UXVirtual Partitions
allow you to easily modify a remote vpar.)
Similarly, if an npar has several active cores (due to Instant Capacity) when it loses contact with
its SRD, you might have to manually size the npar to reclaim those cores for nPars still in the
SRD. For more information, see the Instant Capacity documentation.

How the automatic restart works
When a managed node boots, the gWLM agent (gwlmagent) starts automatically if
GWLM_AGENT_START is set to 1 in the file/etc/rc.config.d/gwlmCtl. The agent then checks
the file/etc/opt/gwlm/deployed.config to determine its CMS.Next, it attempts to contact
the CMS to have the CMS re-deploy its view of the SRD. If the CMS cannot be contacted, the
SRD in the deployed.config file is deployed as long as all nodes agree.
In general, when an SRD is disrupted by a node’s going down, by a CMS's going down, or by
network communications issues, gWLM attempts to reform the SRD. gWLMmaintains the
concept of a cluster for the nodes in an SRD. In a cluster, one node is amaster and the other nodes
are nonmasters. If the master node loses contact with the rest of the SRD, the rest of the SRD can
continuewithout it, as a partial cluster, by unanimously agreeing on a newmaster. If a nonmaster
loses communication with the rest of the SRD, the resulting partial cluster continues operation
without the lost node. Themaster simply omits themissing node until it becomes available again.
You can use the gwlmstatus command tomonitor availability. It can tell youwhether any hosts
are unable to rejoin a node's SRD as well as whether hosts in the SRD are nonresponsive. For
more information, see gwlmstatus(1M).

NOTE: Attempts to reform SRDs might time out, leaving no SRD deployed and consequently
no management of resource allocations. If this occurs, see the VSE Management Software Release
Notes and follow the actions suggested in the section titled “Data Missing in Real-time
Monitoring.”

Related events
You can configure the following HP SIM events regarding this automatic restart feature:
• Node Failed to Rejoin SRD on Start-up
• SRD Reformed with Partial Set of Nodes
• SRD Communication Issue
For information on enabling and viewing these events, refer to Optimize→Global Workload
Manager→Events.
You can then view these events using the Event Lists item in the left pane of HP SIM.
The following sections explain how to handle some of the events.

“Node Failed to Rejoin SRD on Start-up” event
If you see the event “Node Failed to Rejoin SRD on Start-up”:
1. Restart the gwlmagent on each managed node in the affected SRD:

# /opt/gwlm/bin/gwlmagent --restart

2. Verify the agent rejoined the SRD by monitoring the Shared Resource Domain View in HP
SIM or by using the gwlm monitor command.
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3. If the problem persists, check the files /var/opt/gwlm/gwlmagent.log.0 and /var/
opt/gwlm/gwlmcmsd.log.0 for additional diagnostic messages.

“SRD Communication Issue” and “SRD Reformed with Partial Set of Nodes” events

NOTE: Reforming with a partial set of nodes requires a minimum of three managed nodes in
the SRD.

NOTE: “SRD Communication Issue” events are not enabled by default. To see these events,
configure your events in HP SIM through the VSEManagement menu bar using Tools→Global
Workload Manager→Events.

If you have an SRD containing n nodes and you get n - 1 of the “SRD Communication Issue”
events but no “SRD Reformed with Partial Set of Nodes” events within 5 minutes (assuming an
allocation interval of 15 seconds) of the first “SRDCommunication Issue” event, youmight need
to restart the gwlmagent on each managed node in the affected SRD:
# /opt/gwlm/bin/gwlmagent --restart

Manually clearing an SRD
If gWLM is unable to reform an SRD, you can manually clear the SRD, as described in the
following section.

Clearing an SRD of A.02.50.00.04 (or later) agents
The following command is an advanced command for clearing an SRD. The recommended
method for typically removing a host from management is by using the gwlm undeploy
command.
Startingwith A.02.50.00.04 agents, you canmanually clear an SRDwith the following command:
# gwlm reset --host=host

where host specifies the host with the SRD to be cleared.
If this command does not work, use the procedure given in the following section.

Clearing an SRD of agents of any version
The procedure in this section clears an SRD regardless of the version of the agents in the SRD.
The gwlm command is added to the path during installation. On HP-UX systems, the command
is in /opt/gwlm/bin/. On Microsoft Windows systems, the command is in C:\Program
Files\HP\Virtual Server Environment\bin\gwlm\ by default. However, a different
path might have been selected at installation.

NOTE: You must be logged in as root on HP-UX or into an account that is a member of the
Administrators group on Windows to run the commands below.

1. Delete the deployed.config file on each managed node:
# rm -f /etc/opt/gwlm/deployed.config

2. Force an undeploy of the SRD (named SRD below) to ensure the CMS and the managed
nodes agree on the SRD’s state. Run the following command on the CMS:
# gwlm undeploy --srd=SRD --force

3. Restart the gwlmagent daemon on each managed node:
# /opt/gwlm/bin/gwlmagent --restart
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NOTE: If the gWLMCMSand agent disagree aboutwhether an SRD is deployed or undeployed,
you can use the --force option with the gwlm deploy or gwlm undeploy commands.
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Nesting partitions
gWLM allows you to form SRDs consisting of various compartment types. This ability provides
flexibility in dividing your complex. For example, you can divide your complex as shown in
Figure 5-1. The complex has four nPars, two of which are divided into vPars. One npar is hosting
virtual machines, and the fourth npar is not divided. gWLM allows you to create an SRD
containing the two virtual machine guests, the two vPars from npar 2, the two vPars from npar
3, and npar 4. The workloads in any of these compartments can then borrow resources from any
of the other compartments in the SRD. If TiCAP is available on the complex, gWLM can migrate
the usage rights to where they are needed.

NOTE: No more than one deployed SRD per complex should have nested partitions.

Figure 5-1 Nested partitions

Guest 1 Guest 2

HP VM Host

npar 1 npar 2

Temporary Instant Capacity

Complex

vpar 1 vpar 2

npar 3 npar 4

vpar 1 vpar 2

For more information on nesting partitions, see the online help or gwlm(1M).
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Changing the gWLM resource allocation interval
The frequency of gWLM’s changes in the CPU resource allocations is an attribute of the SRDs.
Once you create an SRD, you can change how often gWLM adjusts the CPU resource allocations
of the workloads in that SRD using either of the methods discussed in the following sections.

Changing the interval in HP SIM

NOTE: If you are managing virtual machines, specify a resource allocation interval that is a
multiple of thevm_fssagt interval, which defaults to 10 seconds. If you need a resource allocation
interval of fewer than 10 seconds, set the interval for the VM agents (using vm_fssagt -i) to
the same value as your resource allocation interval.

Using HP SIM, you can set the interval in two places:
• When creating an SRD

From the HP SIM menu bar, select:
Tools→Virtualization Manager...

Then, click the Shared Resource Domain tab. From the VSEManagement menu bar, select:
Create→Shared Resource Domain

• When editing an SRD
From the HP SIM menu bar, select:
Tools→Virtualization Manager...

Then, click the Shared Resource Domain tab. From the VSEManagement menu bar, select:
Modify→Shared Resource Domain

Changing the interval on the command line
Use the gwlm command and a text editor to change the interval on the command line:
1. Use gwlm export to get a copy of the SRD’s XML definition from the gWLM configuration

repository.
2. Edit the “interval” attribute, which is in seconds.

NOTE: If you are managing virtual machines, set the interval attribute value to a multiple
of the vm_fssagt interval, which defaults to 10 seconds. If you need a gWLM interval
attribute value of fewer than 10 seconds, set the interval for theVMagents (usingvm_fssagt
-i) to the same value.

3. Usegwlm import --clobber to place the updated definition in the gWLMconfiguration
repository.
If an SRD of the same name is already deployed, the import operation puts the new interval
into effect. Otherwise, the interval is used the next time you deploy the SRDyou just defined
and imported.

Using gWLM with Hyper-Threading
Hyper-Threading, available starting with HP-UX 11i v3 (B.11.31), enables you to use multiple
execution threads per core. (Cores were formerly known as CPUs.) Each execution thread is a
logical CPU.
Utilization is based on the usage of a core—not a logical CPU. For example, assume a four-core
system has Hyper-Threading enabled so that it has eight logical CPUs. If the system has four
processes, each consuming an entire logical CPU, the reported utilization depends on where
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those processes are. If the processes are on only two cores, the utilization is 50% (2/4). With the
processes distributed across all four cores though, each process can consume an entire core,
resulting in a utilization of 100%.
When fss groups are being used, gWLM disables Hyper-Threading for the default pset, where
fss groups are created, to optimize workload performance.
When an SRD is undeployed, gwlmagent restores the lcpu_attr tunable to the value it had
when the system booted. This value can be different from the value in effect before deployment
if kctunewas used without a reboot.

Using gWLM with hosts on multiple LANs
In data center operations and other cases, you may have hosts on multiple LANs or separated
by firewalls. These hosts might be addressable on a public network or an internal network.
However, they cannot communicate with each other because of the separation by the LANs or
firewalls. Figure 5-2 shows a possible scenario.

Figure 5-2 Using gWLM with hosts separated by firewalls
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On the public network, the hosts can be accessed through their hostnames: vparA, vparB, vparC,
and vparD. However, they cannot access each other through those names.
Although gWLMmight be able to discover the hosts and you can even configure an SRD including
the hosts, when you attempt to deploy the SRD, gWLM will eventually time out and display a
blank screen. No error message is displayed. However, there will be events from each managed
node similar to the following event:
gWLM Agent   MySystem.MyDomain.com
Information  Unable to manage the following hosts:
Associated Exception  Unable to manage the following hosts: MySystem.MyDomain.com: The gWLM agent process on 
the host is not running -- start the agent and retry.

If the environment allows, open ports on the firewalls between the CMS and managed nodes as
documented in the VSE Management Software Version 4.1 Installation and Update Guide for HP-UX
section “Compatibility with HP-UX Bastille and Other Network Firewalls.” If opening firewall
ports on the primary LAN is not an option, use a secondary LAN to manage the hosts.

NOTE: Each gWLM agent must be able to communicate with the CMS and with all the other
agents in the SRD.

A CMS can only manage hosts on the same LAN as the CMS itself. Thus, if you set up a separate
LAN (sometimes referred to as a management LAN or a backup LAN) that includes the CMS
and all the hosts to be managed, you can manage these hosts in a single SRD.
Figure 5-2 shows amanagement LAN inwhich the hosts are known asmgmtA,mgmtB,mgmtC,
andmgmtD.With thismanagement LAN, gWLMcanmanage the hosts in a single SRD.Complete
the following procedure to set up gWLM to manage such hosts in an SRD:
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1. For each host in the management LAN that you want to manage in an SRD:
a. Edit the/etc/opt/gwlm/conf/gwlmagent.properties file to include the following

property:
com.hp.gwlm.security.virtualLocalHostName=hostnameOnLAN

For example, with the host mgmtA, its property would be:
com.hp.gwlm.security.virtualLocalHostName=mgmtA

b. Restart gwlmagent on the host:
# /opt/gwlm/bin/gwlmagent --restart

2. The CMS must also be in the management LAN. If the primary hostname for the CMS is
not the name it uses in the management LAN:
a. Edit the gwlmagent.properties file on the CMS to include the property:

com.hp.gwlm.security.virtualLocalHostName=hostnameOnLAN

On HP-UX, the gwlmagent.properties file is in /etc/opt/gwlm/conf/. On
Windows, it is inC:\Program Files\HP\Virtual Server Environment\conf\.
(The given Windows path is the default; however, a different path might have been
selected at installation.)

b. Restart HP SIM and gwlmcmsd.
3. On each host in the SRD (CMSandmanagednodes),ping every other host in the SRD—using

the hostname you intend to have gWLM discover (its hostnameOnLAN)—to verify
communication is possible.

4. Discover (or re-discover) the hosts using the gWLMManage Systems andWorkloadswizard.

Creating “Golden Images”
If you create golden images of a system’s applications and operating system to store in an IgniteUX
server for distribution to other systems, here are tips for creating images that include gWLM.
When creating an image of a managed node:
• Ensure the gWLM agent is set to start automatically.

In the file /etc/rc.config.d/gwlmCtl, set the variable GWLM_AGENT_START equal to
1.

• Ensure nodeployed SRD includes the node. (If the file/etc/opt/gwlm/deployed.config
exists, an SRD is deployed on the node. Temporarily undeploy the SRD or unmanage the
node.)
If a node based on a virtual partition is part of a deployed SRD and you make a golden
image of the virtual partition, once you push that golden image out, the gWLM agent on
the new systemwill still consider itself part of the SRD. The agentwill then try to rendezvous
with that SRD’s other managed nodes. You can reset the agent by deleting the
deployed.config file (mentioned previously), then stopping and restarting gwlmagent.

Multiple network interface cards
As a client/server application, gWLM is more sensitive than other types of applications to the
network configuration of your host. It supports management only within a single network
domain. For example, if your CMS host has multiple network interface cards that are connected
to multiple distinct networks, gWLM requires that the fully qualified host name resolve to the
IP address that is reachable by the gWLM agents to be managed.
This issue is most often a concern when a host is connected to both of the following items:
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• A corporate LAN/WAN via one network interface card and IP address
• A second, private internal network and private IP address for communicatingwith a certain

other set of hosts (such as cluster members)
Global Workload Manager attempts to detect and report network configuration issues that can
cause undesirable behavior, but in some cases this detection occurs in a context that can be
reported only into a log file.
Workaround If you encounter some unexpected behavior (such as a gWLM agent that fails to
update or report the status of its workloads), inspect the /var/opt/gwlm/glwmagent.log.0
file on the host for errors.

Incorrectly configured host name or IP address
You might see the following message in a log file (gwlmagent.log.0 or gwlmcmsd.log.0):

Unable to determine the network address and/or hostname
of the current host. This indicates a mis-configured network and/or a host
name resolution issue for this host. For troubleshooting information, see the
VSE Management Software Release Notes and search for this message. 

The most common cause for this error is a problem in the host name configuration file in /etc/
hosts (or equivalent on Windows) or incorrect settings of the /etc/nsswitch.conf file
(HP-UX only).
Background information gWLM is not a simple client/server application. It involves:
• Multiple managed-node “servers” (the set of gWLM agents in an SRD are all peer servers

that cooperatively manage the SRD)
• The CMS management server handling configuration and monitoring
Under normal operation, all of these components need complete connectivity. At a minimum,
gWLM requires that each host have a primary IP address/host name that is reachable from every
other interacting gWLM component--the CMS and all gWLM agents in a single SRD. (gWLM
agents in multiple SRDs need not have connectivity within undeployed SRDs.)
By default, gWLM uses the primary IP address/host name for a given host. However, you can
set up a management LAN. To use other IP addresses/host names, see Using gWLMwith Hosts
on Multiple LANs.
Workaround Correct the configuration of the host so that:
• The primary fully qualified domain name can be properly resolved (by DNS or by

configuration files)
• The IP address and primary fully qualified domain name are consistent for the host—and

do not resolve to a local-host address (for example, 127.0.0.1)
The procedure below explores one way to check the host's configuration.
1. Run the vseassist tool to perform initial network configuration checks.
2. To validate proper configuration on HP-UX, try the following steps:

a. Get the current host name using the hostname command:

  [mysystem#1] > hostname
  mysystem

b. Get the IP address configured for the host using nslookup:

  [mysystem#2] > nslookup mysystem
  Trying DNS
  Name:   mysystem.mydomain.com
  Address:  15.11.100.17
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c. Verify that /etc/hosts has the same name configured for the address. Note that the
first name should be the fully qualified domain name, and any aliases are listed
afterward.

  [mysystem#3] > grep 15.11.100.17 /etc/hosts
  15.11.100.17    mysystem.mydomain.com mysystem

d. Verify that the reverse lookup of the IP address returns the same fully qualified domain
name as configured in /etc/hosts.

  [mysystem#4] > nslookup 15.11.100.17 
  Trying DNS
  Name:    mysystem.mydomain.com
  Address:  15.11.100.17

Fix any issues by editing /etc/hosts or for additional information, see:
• TheHP-UX IPAddress and ClientManagement Administrator's Guide, available online at http://

www.hp.com/go/bizsupport.
• The BIND 9 Administrator ReferenceManual, available from the Internet Systems Consortium

at http://www.isc.org/sw/bind/arm93.
• The Windows documentation.

Unable to create new native thread
A message containing the following text might be displayed:
... unable to create new native thread

Workaround This problem occurs because the following kernel parameters are set too low:
• max_thread_proc

Set max_thread_proc to at least 256.

• nkthread

Set nkthread to allow for your max_thread_proc value as well as the number of threads
needed by all the other processes on the system.
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6 Support and other resources
This chapter contains support information and the available resources for the HP Insight Global
Workload Manager software for Integrity.

Contacting HP

Before you contact HP
Be sure to have the following information available before you call contact HP:
• Technical support registration number (if applicable
• Product serial number
• Product model name and number
• Product identification number
• Applicable error message
• Add-on boards or hardware
• Third-party hardware or software
• Operating system type and revision level

HP contact information
For the name of the nearest HP authorized reseller:
• See the Contact HP worldwide (in English) webpage (http://www.hp.com/country/us/en/

wwcontact.html).
For HP technical support:
• In the United States, for contact options see the Contact HP United States webpage (http://

welcome. hp.com/country/us/en/contact_us.html). To contact HP by phone:
— Call 1-800-HP-INVENT (1-800-474-6836). This service is available 24 hours a day, 7 days

a week. For continuous quality improvement, calls may be recorded or monitored.
— If you have purchased a Care Pack (service upgrade), call 1-800-633-3600. For more

information about Care Packs, refer to the HP website (http://www.hp.com/hps).
• In other locations, see the Contact HP worldwide (in English) webpage (http://

welcome.hp.com/ country/us/en/wwcontact.html).

Subscription service
HP recommends that you register your product at the Subscriber's Choice for Business website:
http://www.hp.com/country/us/en/contact_us.html
After registering, you will receive email notification of product enhancements, new driver
versions, firmware updates, and other product resources.

Documentation feedback
Your comments and suggestions regarding product features can helpHPdevelop future versions
of the VSE Management Software.
Use the following email address to send feedback directly to the gWLM development team:
gwlmfeedback@rsn.hp.com.
Include the document title andmanufacturing part number. All submissions become the property
of HP.
For comments on VSE Management Software other than gWLM, send feedback directly to the
VSE Management Software development team: vse@hpuxweb.fc.hp.com.
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NOTE: HP cannot provide product support through these email addresses. To obtain product
support, see “Contacting HP” (page 51).

For a forum with other gWLM users, visit the IT Resource Center’s forum for
HP-UX Workload/Resource Management:
http://forums.itrc.hp.com/cm/CategoryHome/1,,213,00.html

New and changed information in this edition
The following additions and changes have been made for this edition:
• A limitation has been added to:

— Appendix B Global Workload Manager 6.2 Known issues

Publishing history

Publication Date
Supported Operating
SystemsgWLM ReleaseManufacturing Part Number

October 2010HP-UX 11i v1
HP-UX 11i v2
HP-UX 11i v3

A.6.2.0*T8672-90019

February 2010HP-UX 11i v1
HP-UX 11i v2
HP-UX 11i v3

A.6.0.0*5992-5060

January 2009HP-UX 11i v1
HP-UX 11i v2
HP-UX 11i v3

A.04.01.00.*T8672-90010

May 2008HP-UX 11i v1
HP-UX 11i v2
HP-UX 11i v3

A.04.00.07T8672-90001

June 2007HP-UX 11i v1
HP-UX 11i v2
HP-UX 11i v3

A.03.00.00T2762-90057

Related information
The latest versions of manuals, product information, and white papers for HP Insight Dynamics
- VSE Suite, can be viewed or downloaded from http://www.hp.com/go/insightdynamics/docs.
For more information about HP Insight Dynamics - VSE, the VSE Management software, and
VSE-related products and solutions, visit the following HP websites:
• HP Insight Dynamics - VSE for Integrity: http://www.hp.com/go/insightdynamics/integrity
• HP Insight Dynamics - VSE: http://www.hp.com/go/insightdynamics

Typographic conventions
This document uses the following typographic conventions.
Book Title Title of a book or other document.
Linked Title Title that is a hyperlink to a book or other document.
http://www.hp.com A website address that is a hyperlink to the site.
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Command Command name or qualified command phrase.
user input Commands and other text that you type.
computer output Text displayed by the computer.
Enter The name of a keyboard key. Note that Return and Enter both refer

to the same key. A sequence such as Ctrl+A indicates that you must
hold down the key labeled Ctrl while pressing the A key.

variable The name of an environment variable, for example PATH or errno.
value Avalue that youmay replace in a commandor function, or information

in a display that represents several possible values.
find(1) HP-UX manpage. In this example, “find” is the manpage name and

“1” is the manpage section.
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A Compatibility with agents
The gWLM A.6.2.0.* CMS runs on HP-UX 11i v1 (B.11.11), HP-UX 11i v2 (B.11.23), HP-UX 11i
v3 (B.11.31), andMicrosoftWindows systems. It workswith the following versions of the agents:
• gWLM A.03.00.00.05: HP-UX 11i v1, HP-UX 11i v2, HP-UX 11i v3
• gWLM A.03.00.01.05: HP-UX 11i v1, HP-UX 11i v2, HP-UX 11i v3
• gWLM A.04.00.07: HP-UX 11i v1, HP-UX 11i v2, HP-UX 11i v3
• gWLM A.04.01.00.*: HP-UX 11i v1, HP-UX 11i v2, HP-UX 11i v3
• gWLM A.6.0.0.*: HP-UX 11i v1, HP-UX 11i v2, HP-UX 11i v3
• gWLM A.6.2.0.*: HP-UX 11i v1, HP-UX 11i v2, HP-UX 11i v3

NOTE: While gWLMdoes support the earlier agent versions listed above, you are encouraged
to upgrade to the latest version.

Use thegwlmstatus commandon amanagednode to determine the version of the gWLMagent
software on that node.
Also, all gWLM agents within an SRDmust be the same version: A gWLM CMS can manage an
SRD that uses only A.04.00.07 agents, only A.03.00.01.05 agents, only A.03.00.00.05 agents, and
so forth.
The new features introduced with a new agent version are typically not backward-compatible.
For information on the key features supportedwith each supported agent version, see the section
"Working with earlier gWLM versions" in gwlmxml(4).
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B Global Workload Manager A.6.2.0.* Known issues
This appendix contains the limitations and known issues for the Global Workload Manager
(gWLM) A.6.2.0.* release.

Limitations
The following are limitations for Global Workload Manager.

HP Integrity Superdome 2 support
HP Global Workload Manager (gWLM) supports fss, psets, and HP Integrity Virtual Machines
on HP Integrity Superdome 2. It does not support nPars and vPars. Online migration of CPU is
also not supported.

Unpredictable management when removing GiCAP group members
If you have removedhosts fromaGiCAPgroup before removing them froman SRD,management
of the SRDbecomes unpredictable. Youmight not be able tomodify the SRDor perform a normal
undeploy, in which case you must force an undeploy, delete the SRD, and re-create it.
Workaround Unmanage any group members before removing them from the GiCAP group.

Localization behaviors
Starting with the 4.0 release, gWLM has been localized into several languages. However:
• When managing a gwlmagent version prior to 4.0, some error messages are still displayed

in English
• Events reported to HP SIM are reported in English regardless of the browser locale.
• A change in the browser locale setting is reflected in:

— VSEMgmt software at the start of the next user-interface action
— HP SIM at the next logon

• The properties files for gwlmagent and gwlmcmsd are parsed as English, regardless of the
locale setting. So, be careful of using commas where English would use periods.

• Some items are always in English:
— Start-up messages from gwlmagent and gwlmcmsd
— Log files
— Messages from initial configuration

Unable to manage partitions with inactive cells or deconfigured cores
gWLM does not support management of partitions with either inactive cells or deconfigured
cores. (gWLMmight incorrectly try to allocate and assign those unavailable resources.)
Workaround Configure the cores and activate the cells.

Unable to build a single shared resource domain
The following message might be displayed in the HP SIM interface to gWLM:
Unable to build a single shared resource domain from the set of specified hosts: myhostA.mydomain.com 
myhostB.mydomain.com

Workaround Thismessage indicates that there are no supported resource-sharingmechanisms
available between the specified hosts. The message can occur if:
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• You have specified hosts in different complexes and the complexes are not managed in the
same GiCAP group.

• You have specified hosts in different nPartitions in a complexwhen there are no iCAP usage
rights to share between the nPartitions.

• The cimserver (or a provider) on one or more hosts is not functioning properly and
consequently complex or partition IDs are not discovered properly.

If you receive this message:
• Inspect the /var/opt/gwlm/gwlmagent.log.0 files on the indicated managed nodes

for error messages.
• If partitions have been renamed, restarting the agents in the complex might correct the

problem.
• If available, inspect the discovery tree for unexpected difference in complex or partition

names. Check the functioning of theparstatus,icapstatus andvparstatus commands
on the hosts which do not have the expected IDs. Restarting the cimserver on those hosts
might correct the problem.

Compatibility with PRM and WLM
You cannot use gWLM with either Process Resource Manager (PRM) or Workload Manager
(WLM) to manage the same system at the same time. Attempts to do so result in a message
indicating that a lock is being held by whichever application is actually managing the system.
To use gWLM in this situation, first turn off the application holding the lock.
For PRM, enter the following commands:
# /opt/prm/bin/prmconfig -d
# /opt/prm/bin/prmconfig -r

For WLM, enter the following command:
# /opt/wlm/bin/wlmd -k

Rare incompatibility with virtual partitions
Depending onworkload characteristics, gWLMcanmigrate CPU resources rapidly. This frequent
migration can potentially, although very rarely, produce a race condition, causing the virtual
partition to crash. It can also produce a panic, resulting in one ormore of the followingmessages:
No Chosen CPU on the cell-cannot proceed with NB PDC.

or
PDC_PAT_EVENT_SET_MODE(2) call returned error

Workaround Upgrading to vPars A.03.04 resolves this issue.
With earlier versions of vPars, you can work around this issue as follows: Assign (using path
assignment) at least one CPU per cell as a bound CPU to at least one virtual partition. (It can be
any virtual partition). This ensures that there is no redesignation onCPUmigrations. For example,
if you have four cells (0, 1, 2, 3), each with four CPUs (10, 11, 12, 13) and four virtual partitions
(vpar1, vpar2, vpar3, vpar4), you could assign 0/1x to vpar1, 1/1x to vpar2, 2/1x to vpar3, and
3/1x to vpar4, where x is 0,1,2,3.

Workloads in gWLM do not follow associated Serviceguard packages
With the exception of virtual machines, a workload can be managed by gWLM in only one
deployed SRD at a time. As a result, if a workload is directly associated with a Serviceguard
package (using the selector in the Workload Definition dialog), gWLM can manage it on only
one of the hosts on which it might potentially run. However, management of such a workload
might disrupt the Virtualization Manager and Capacity Advisor tracking of the workload
utilization between cluster members. Thus, it is recommended that you not directly manage a
workload associated with a Serviceguard package.
Workaround For all hosts to which a workload associated with a Serviceguard package might
fail over, you must apply a policy to an enclosing operating system instance (virtual partition or
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nPartition). You can use a gWLM conditional policy to change the resource allocation depending
onwhich packages are present. This enables you to control the resource allocation of the enclosing
operating system instance and still monitor the workload via Virtualization Manager.

Host name aliases are not supported
Host name aliases are not supported by gWLM. Only canonical DNS host names (fully qualified
domain names) are supported.
Workaround Use only canonical DNS nameswhen configuring gWLM through either HP SIM
or an XML file used with the gwlm command.

Making a configuration change to a large SRD is slow
Changesmade to the configuration of a large SRD that is deployedmight take a long time (several
minutes) to take effect.
Workaround There is no workaround. The amount of time needed to complete a change
depends on the time it takes to communicate with all the compartments in the SRD.

Events for gWLM CPU migration can affect HP SIM CMS performance
TheHPproducts SystemFaultManagement (SFM) andEventMonitoring Service (EMShardware
monitors in particular) generate events, or indications, when CPUs are migrated. Depending on
workload characteristics, gWLM can migrate CPUs rapidly. Over time, this frequent migration
can result in a high enoughnumber of events that the performance of theHPSIMCMS is adversely
affected.
Workaround The following options are available as workarounds:
Option 1 For systemsmanaged by gWLM that are runningHP-UX 11i v3, install the patches

PHCO_36126 and PHSS_36078. (These patches are included in the September 2007
Operating Environment Update Release.) A fix to EMS hardware monitors is
available with the September 2007 Operating Environment Update Release. Even
with these patches and fixes, there is still one event generated for each change in
CPU count.
For systems managed by gWLM that are running HP-UX 11i v2, upgrade to the
June 2007 Operating Environment Update Release.

Option 2 Upgrade toHP SIMC.05.01.00.01.xx on the CMS. This version of HP SIMdoes not,
by default, subscribe to these events andwill not have a performance degradation.

Option 3 If you want to subscribe to events, set up automatic event purging in HP SIM.
Formore information about any of theseworkarounds, see theHP SIMdocumentation (available
from http://www.hp.com/go/hpsim).

Deleting workloads takes a long time
Once a request to delete aworkload is issued, it can take a long time (severalminutes) to complete
the deletion.
Workaround Remove old historicalmonitoring and configurationdata from the gWLMdatabase
by entering the following command:
# gwlm history --truncate --truncate=<CCYY/MM/DD>

If you prefer not to trim the database, you can delete multiple workloads simultaneously using
the gwlm delete command.
For more information, see gwlm(1M).

Integrity VM prevents discovery of psets and fss groups
When the gWLM agent is installed on a system that has Integrity VM installed, discovery
operations report only Integrity VM compartments even if psets and fss groups are present.
Workaround To discover psets or fss groups on the system, you must remove Integrity VM.
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Only workloads with managed siblings can be added to SRDs with nested partitions
Using the gWLM command-line interface, you cannot add aworkload to an SRD that has nested
partitions unless a sibling of that workload is already managed in that SRD.
Workaround This is not an issue when you use the gWLM interface in HP SIM. Simply follow
the instructions in Step 1 of the Manage Systems and Workloads wizard (reached by selecting
Create→Shared Resource Domain), and select the set of hosts to include in a single SRD.

Configurations with Psets nested in virtual partitions rejected with vPars versions
earlier than vPars A.03.05

gWLMdoes not support nesting psets in virtual partitions when the vPars version is earlier than
vPars A.03.05. However, it has not always rejected such configurations. gWLM4.0 and later does
reject these configurations though. So, configurations you used with gWLM 2.x or gWLM 3.x
can be rejected when you begin using gWLM 4.0 (and later) agents. Given such a configuration,
if the SRD is undeployed before upgrading the agents, the re-deployment of the SRD will fail
with an error message. If the SRDwas left deployed while the agents were upgraded, the agents
will not be able to restore SRD operations. Also, SIM events will be generated to report the
validation failure.
Workaround There are two workarounds:
• Update to vPars A.04.00 or later.
• Update your configurations so that psets are not nested in virtual partitions.

Information error during shutdown
You might see a message similar to the following:
Information Error during shutdown. The unbinding of objects in the
registry might have failed, and the workload management lock has not
been released. Associated Exception
com.hp.gwlm.common.JniPlatformException: prm_ctrl_rel_cfg_lock failed
because vm_fssagt:8343 is the lock owner

Workaround You can safely ignore this message.

Managing fss groups on systems with psets restricts fss groups
When a system has psets, gWLM uses only pset 0 for fss groups. gWLM is able to manage CPUs
that are allocated only to pset 0.
Workaround There is no workaround; this is simply how fss groups are implemented on a
system with psets. You can continue with your fss groups inside pset 0 (leaving the other psets
unmanaged), manage using psets instead (ignoring fss groups), or remove all the psets (other
than pset 0) using the following command:
# psrset -d all

Custom metrics lost on redeploy
Custompolicies usemetric values that you provide via the gwlmsend command. If you redeploy
an SRD that has a custom policy, the most recent value for the policy's metric is lost. In this
situation, gWLMbases its allocations on theminimum request specified in theworkload's policy.
The workload can also receive any CPU resources that remain after all the policies have been
satisfied.
Workaround Update themetric values for all your custompolicies immediately after a redeploy.

Process placement using psrset is ignored
When gWLM is managing the psets on a system, every process on the system has to go in a
workload. gWLMplaces the processes according to application records or user records specified
when you create or edit a workload definition. If no records exist, the processes are subject to
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the placement rules, which are explained in the online help topic "pset / fss group tips" in the
section "Precedence of placement techniques."
If you use thepsrset command to place processes in psets, gWLM is likely tomove the processes
to the default pset.
Workaround To maintain the placement of a process, use gWLM's application records or user
records when creating or editing your workload definitions in gWLM. If using records is not
practical, use the gwlmplace command. However, you will have to use gwlmplace after each
redeploy of an SRD to put the processes back in the desired workloads.

iCAP compliance warning
gWLMmight give the following warning:
Warning: gwlmagent cimserver error, icapd down, or icap out of
compliance. First restart cimserver. Make sure icapd is running. If
this error happens again, consult gwlmagent man page for steps to return
to compliance.

Workaround Verify that no partition changes (parmodify) are pending. If partition changes
are pending, please restart the system. Then, either consult iCAP documentation or contact HP
to return the iCAP system back to compliance.

Major issues
The following are major issues for Global Workload Manager.

gWLM fails to start with certain time zone settings
gwlmcmsd andgwlmagent can fail to startwith certain time zone settings. The followingmessage
is displayed in the gwlmagent.log.0 file or the gwlmcmsd.log.0 file when you attempt to invoke
either daemon:

Unable to call method, 'main', with signature, 
'([Ljava/lang/String;)V', in class, 'com/hp/gwlm/node/Node'.
Exception in thread "main"

Workaround Use Java 1.5.0.12 or later.

gWLM commands core dump
Attempts to run gwlm commands result in core dumps when /var is full.
Workaround Make space available in /var.

Multiple time changes on CMS might render gWLM unusable
If the time on the CMS is changed to a point in the future, changes to the gWLM configuration
are made and time on the CMS is moved back to the present; gWLMwill not recognize any new
changes as the latest configuration.
Workaround Backup the CMS before performing any changes to time on the CMS system.

PHKL_39587 patch required on HP-UX 11i v3 Integrity VM hosts
The HP-UX 11i v3 (B.11.31) PHKL_39587 patch is required on an HP Integrity Virtual Machines
host that is to bemanaged by gWLM. If the patch is not installed, communication between gWLM
and the Integrity VM host might hang for one to many hours, in which event operating virtual
machines might not be allocated the CPU resources they need.
Workaround Install the HP-UX 11i v3 (B.11.31) PHKL_39587 patch on all HP Integrity Virtual
Machines hosts.
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Documentation or minor issues
The following are minor issues for Global Workload Manager.

Cell-Local processors and iCAP environment
Using cell-local processors with virtual partitions inside an nPartition that uses (iCAP) leads to
failure of the icod_modify command.
Workaround Do not assign CPUs using cell specifications. Consider assigning CPUs to the
virtual partitions using a hardware path.
Alternatively, to use cell-local processors, update to vPars A.04.04 on HP-UX 11i v2 (B.11.23) or
to vPars A.05.01 on HP-UX 11i v3 (B.11.31).

CMS is slow to respond
The CMS is slow to respond.
Workaround Time a gwlm list command on the CMS. If it takes more than 10 seconds,
perform the following steps:
1. In the file /etc/opt/gwlm/conf/gwlmcms.properties (HP-UX) or

install-path\VirtualServerEnvironment\conf\gwlmcms.properties
(Windows), increase the CMS database cache size by increasing the value of the
com.hp.gwlm.cms.cachesize property by 25%. (The cache is more memory efficient if
the size is near a power of 2. If your target cache size is close to a power of 2, round it up to
the next power. For example, if your target cache size is 60,000, round it up to 66,000.)

2. Stop and restart gwlmcmsd using the following commands.

NOTE: Stopping gwlmcmsd disables Virtualization Manager and Capacity Advisor.

# gwlmcmsd --stop
# gwlmcmsd

Combining psets and virtual partitions
When using psets on virtual partitions, assigning CPUs to virtual partitions by either path or
cell specification can result in processes losing their processor set affiliations when CPUs are
removed.
Workaround Two workarounds are available:
• Do not assign CPUs to virtual partitions by either path or cell specification.
• Set the gWLM policy minimum for pset 0 (the default/OTHERworkload) to be greater than

or equal to the sum of path-specific CPUs and cell-specific CPUs.

Error during discovery of compartments
The following message might be displayed when you use the Manage New Systems wizard or
the gwlm discover command:
Error during discovery of compartments.

In addition, the /var/opt/gwlm/gwlmagent.log.0 file contains the following message:
com.hp.gwlm.common.PlatformException: /usr/sbin/parstatus -w exited
with a non-zero exit status. Captured stderr is: Error: Unable to get
the local partition number.

Workaround This is most likely due to having an outdated version of the nPartition Provider
software. Global Workload Manager uses a command that is made available by the nPartition
Provider, which is typically in every version of HP-UX, to determine system capabilities.
You can also use the /opt/vse/bin/vseassist command to diagnose the issue.
Install the latest nPartition software, even if you are not using nPartitions.

62 Global Workload Manager A.6.2.0.* Known issues



For HP-UX 11i v1, use version B.11.11.01.03.01.01 or later.
For HP-UX 11i v2 on HP 9000 servers, use version B.11.23.01.03.01.01 or later.
For HP-UX 11i v2 on HP Integrity servers, use version B.11.23.01.04 or later.
You can find the nPartition Provider at the following locations:
• The quarterly AR CD starting May 2005
• The Software Depot website: http://software.hp.com

Modifying Java while gWLM is running
gWLM does not support any actions (including the use of update-ux) that remove, overwrite,
or otherwise modify the version of Java that gWLM is using in a managed node or CMS that is
part of a deployed SRD.
Workaround Undeploy an SRD before taking any actions that affect the version of Java that
gWLM is using on systems that are part of the SRD. If you used update-ux, be sure to:
• Restart the CMS daemon on the CMS

Using the command-line interface: /opt/gwlm/bin/gwlmcmsd
Using theHP SIM interface: Select themenusConfigure → Configure VSE Agents → Start
gWLM CMS Daemon

• Restart the agent on the managed nodes
Using the command-line interface: /opt/gwlm/bin/gwlmagent
Using theHP SIM interface: Select themenusConfigure → Configure VSE Agents → Start
gWLM Agent

Missing or unexpected historical data (system clocks differ)
You might have no historical data available for graphing, even though you are certain an SRD
was deployed for the time period in question.
A related issue occurs when you select a time period where you expect high system activity, but
the graph shows limited activity. Similarly, youmight expect very little activity for a time period,
but the graph shows lots of activity.
Workaround Check that the system clocks on the CMS and on all the systems in the SRD are
synchronized. If the clocks differ significantly, gWLMmight not be able to match the data from
the managed nodes with the time period you are trying to graph.

Sample missing at start or end of gwlmreport output
A report from gwlmreport is based on a report period that starts at midnight the day the report
begins and ends at midnight the day the report ends. Any samples that overlap midnight at the
start or end of the report period are excluded from the report.
Workaround There is no workaround, but you should be aware of this behavior.

Workload with fixed policy gets more resources than requested
In an SRD with nested partitions, assigning fixed policies where the sum of the fixed values is
less than theminimumof the parent compartment can result inworkloads gettingmore resources
than specified in the fixed policies.
Workaround Set up the fixed policies so that the number of CPUs requested is greater than or
equal to the minimum number of CPUs required by the parent compartment.

Only one SRD is allowed to be deployed
You might see a message similar to the following:
Error trying to deploy SRD, mysystem.vpar.000 to mysystem2.mydomain.com.
SRD, mysystem2.fss.000 is already deployed. Only one SRD is allowed to
be deployed.
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Workaround Undeploy the SRDusing the--forceoptionwith thegwlm undeploy command,
and restart gwlmagent on the managed node.

SRD deployment times out and displays a blank screen
If you attempt to deploy an SRD, but:
• gWLM times out and displays a blank screen
• There are events from each managed node similar to the following event:

gWLM Agent MySystem.MyDomain.com
Information Unable to manage the following hosts:
Associated Exception Unable to manage the following hosts: MySystem.MyDomain.com: The gWLM agent 
process on the host is not running -- start the agent and retry.

You need to configure gWLM to work with hosts on multiple LANs.
Workaround See Using gWLM with Hosts on Multiple LANs for information on configuring
gWLM to work with hosts on multiple LANs.

Application hangs in fss group
On HP-UX 11i v2 (B.11.23), an application inside an fss group might hang when running in a
single-processor virtual partition, nPartition, or system.
Workaround Install patch PHKL_33052.

Scripts not placed in correct workloads
With compartments based on psets or fss groups, gWLM allows you to place scripts in the
compartments using application records with alternate names. This works only if the shell or
interpreter being used is listed in the file /etc/shells. Typically, perl is not in this file. So,
perl scripts (and any other scripts based on shells or interpreters not listed in /etc/shells)
are not properly placed.
Executables are not affected by this issue.
Workaround Add /opt/perl/bin/perl, and any other needed shells or interpreters, to the
file /etc/shells. Global Workload Manager will recognize the added shells or interpreters
within 30 seconds.

NOTE: Because the full pathname is not required for the script, a rogue user could get access
to compartments based on psets or fss groups — that would otherwise not be accessible — by
using the name of the script for new scripts or wrappers.

Processes moved to default pset or default fss group
All process placement with the gwlmplace command on a managed node is lost if:
• The managed node is rebooted.
• The local gwlmagent daemon is restarted.
• You undeploy the current SRD.
In these cases, processes are placed according to any application records or user records that
apply. If no records exist, nonroot processes are placed in the default pset or default fss group;
root processes are left where they are.
Workaround To maintain the process placements across redeploys, use gWLM's application
records or user records when creating or editing your workload definitions in gWLM.

Sizes/allocations less than policy minimums for Virtual Machines
The sizes or allocations for virtual machines in a deployed SRD can appear to be less than their
policy minimums.
Workaround Wait a few minutes, since it can take several minutes for gWLM to recognize a
virtual machine transition between the states of off and on.
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Starting management of monitored workloads with pset compartments
If you attempt tomanage a set ofmonitoredworkloads by applying a policy andmanaging them
with pset compartments, you might get the following error when attempting to complete the
Workload & Policies step of theManage Systems &Workloads Wizard:
The value '0' specified for 'Total Size' must be a positive integer
value.

This message is displayed when you attempt to manage a set of pset compartments that require
more cores than are available on the managed node. A pset has a minimum size of one core, so
you need at least as many cores as workloads you are attempting tomanage. TheTotal Size field
cannot be calculated when there are not enough resources on the system to manage the set of
monitored workloads in pset compartments.
Workaround You can manage the workloads using compartments based on fss groups (which
have a smallerminimumsize), or add resources to the partition or SRD, to fulfill the psetminimum
size requirements.

Unable to remove workload from nested partitions SRD
When attempting to remove the last (default) fss group from an SRDwith nested partitions, you
might encounter a message that includes the following text:
Unable to remove workload workload_name: Attempting to remove a
compartment with an unachievably low Fixed policy size. Increase the
Fixed policy resource amount and try again.

Workaround Undeploy the SRD and delete it. Then, create a new SRD without the fss group
that you were trying to remove.

Discovery does not show current information for stopped virtual machines
Global Workload Manager discovery does not always report current information for stopped
virtual machines. Specifically, when a virtual machine is stopped and the number of vCPUs is
changed, gWLM discovery does not show the changed number of vCPUs. Instead, it shows the
number of vCPUs from the virtual machine's most recent start.
Workaround Start the virtual machines before performing discovery.

Configuration of agent and CMS not synchronized
Occasionally, a gWLM agent and the gWLM CMS disagree on whether an SRD is actually
deployed. This can occur when you useCtrl-C to interrupt a gwlm deploy or gwlm undeploy
command. It can also occur if there are errors saving a gWLM configuration; the configuration
is deployed and then saved to the gWLM configuration repository. If the deploy occurs but the
save fails, the gWLM agent sees the SRD as deployed; however, the CMS sees the SRD as
undeployed.
Workaround Use the--force optionwithgwlm deploy orgwlm undeploy to synchronize
the agent and the CMS.
For example, run the following command to force both the agent and the CMS to consider the
SRD as deployed, substituting the name of your SRD for SRD
# gwlm deploy --srd=SRD --force

For more information about the gwlm command, see gwlm(1M). The agents should be restarted
to clear their configuration. The following steps should be performed on all agents:
# gwlmagent --stop
# rm /etc/opt/gwlm/deployed.config
# rm /var/opt/gwlm/RPmap (If it exists.)
# gwlmagent 
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Missing historical data (gWLM CMS daemon/service restarted)
Youmight have blank sections of a historic report for a workload, or youmight see the following
error message when displaying historic data for a workload:
There is no gWLM historical data for the workload MyWorkload.wkld. The
workload has never been managed by gWLM, or the historical data has
been removed.

Because of caching gWLMhistoric data inHP SIM, if the gWLMCMSdaemon/service is restarted
after initially viewing historic data, the interface incorrectly reports that there is no data available
to view or fails to load portions of the data.
Workaround Perform the following steps:.
1. Log out of HP SIM
2. Log in to HP SIM (again)
3. Generate the historic report (again)

Negative current size for NONVM
If the CPUs on a VM Host are oversubscribed when you deploy an SRD on that host, gWLM
shows current size for NONVM as a negative value.
Workaround Two options are available:
• Adjust the entitlements of those virtual machines that are on so that the CPUs are not

oversubscribed.
• Stop one or more virtual machines until those still on do not oversubscribe the CPUs.

Unmanaging a Virtual Machine that is on leaves SRD undeployed
When attempting to unmanage a virtual machine that is started, the SRD can be undeployed,
even though the following message is displayed:
The virtual machine VM_name on host hostname is on but does not have
an associated gWLM policy. Please turn the virtual machine off, or apply
a gWLM policy to provide the necessary resources.

Workaround Turn off the virtual machine and redeploy the SRD that contained it.

gWLM online help corrections
The following are corrections to gWLM online help topics:
• Specify Workload/Policy Settings: In 3a, the tilde (“~”) and parentheses (“(” and “)”) are also

legal characters inworkload names. That is, you can use the tilde and parentheses characters
in workload names.

• Compatibility with Agents: In the bullet list of compatible agents, replace “gWLMA.04.10.xx”
with “gWLM A.04.01.xx”.

Workaround N/A
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